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ΠΕΡΙΛΗΨΗ 
 

Το θεματικό αντικείμενο της παρούσας πτυχιακής εργασίας είναι η 

επίλυση προβλημάτων παιγνίων με τη χρήση του προγράμματος Gambit 

(έκδοση 14.1.0 ) ,αλλά και η κατανόηση όσον αφορά τις λειτουργίες του 

προγράμματος.  

Το πρώτο στάδιο της πτυχιακής είναι η ανάλυση της θεωρίας παιγνίων 

όπου περιλαμβάνονται μια ιστορική αναδρομή σχετικά με την εξέλιξη 

της θεωρίας αυτής καθώς επίσης διατυπώνονται ορισμένες από τις 

βασικότερες έννοιες της. 

Στη συνέχεια, γίνεται μια εισαγωγή στο πρόγραμμα Gambit, όπου 

δίνονται πληροφορίες σχετικά με τα βασικά χαρακτηριστικά του το 

λογισμικού του προγράμματος και το γραφικό περιβάλλον του.  

Στο επόμενο στάδιο, αναφέρονται αναλυτικά όλες εκείνες οι ενέργειες 

που «περιστρέφονται» γύρω από την εισαγωγή και την επίλυση τον 

προβλημάτων παιγνίων. 

Τέλος, η πτυχιακή αυτή εργασία ολοκληρώνεται με την παρουσίαση και 

επίλυση ορισμένων παραδειγμάτων στο πρόγραμμα Gambit. 
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ABSTRACT 
 

The topic of this degree thesis is to solve gambling problems using 

Gambit program (version) 14.1.0, but also the understanding of the 

functions of the program. 

The first part of this degree thesis is the analysis of game theory 

including a historical overview on the development of this theory. 

Moreover, there are contained certain basic concepts of gambling theory. 

Subsequently, there is an introduction to Gambit program, where there 

are given some information about the main features of the software and 

the user interface on Gambit program. 

In the next part includes all these actions that resolve around the 

inputting and solving the problems of gambling. 

Finally, this degree thesis concludes with the presentation and resolution 

of examples in Gambit program. 
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ΚΕΦΑΛΑΙΟ ΠΡΩΤΟ  

ΘΕΩΡΙΑ ΠΑΙΓΝΙΩΝ  
 

1.1 Ιστορική Αναδρομή 
 

Η θεωρία παιγνίων ξεκίνησε ως ένα μαθηματικό υπόδειγμα με 

στόχο τη διαφώτιση της συμπεριφοράς των ορθολογικών παικτών μέσα 

σε ένα παίγνιο. Το πρώτο σύγγραμμα «Theory of Games and Economic 

Behavior» εκδόθηκε από τους John von Neumann και Oscar 

Morgenstem. Η μεγαλύτερη αδυναμία κατά την αρχή της θεωρίας ήταν 

απόδοση της βέλτιστης συμπεριφοράς δίχως τον υπολογισμό της 

αντίδρασης των υπόλοιπων παικτών. Με το πέρας του χρόνου όμως η 

θεωρία παιγνίων χρησιμοποιείται σε πολλούς τομείς της κοινωνίας. 

Σημαντικοί θεμελιωτές της είναι οι: 

 John Forbes Nash : επινόησε την λύση ισορροπίας Nash 

που αφορούσε προβλήματα μη μηδενικού αθροίσματος. 

 Reinhard Selten : δημιούργησε το εναρκτήριο λάκτισμα για 

την ικανοποιητική λύση προβλημάτων που αφορούσαν 

δυναμικά παιχνίδια. 

 John Harsanyi : επικεντρώθηκε στα παιχνίδια με μερική 

πληροφόρηση. 

Πλέον η θεωρία παιγνίων είναι ένας κλάδος της 

Μικροοικονομικής που ασχολείται με την ανάλυση της άριστης λήψης 

αποφάσεων σε ανταγωνιστικές καταστάσεις μέσα στο οικονομικό και 

κοινωνικό περιβάλλον.  
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 1.2 Σκοπός Θεωρίας Παιγνίων. 
 

Η θεωρία παιγνίων μπορεί να χρησιμοποιηθεί σε διάφορες 

καταστάσεις και περιπτώσεις όπως η συνεργασία ή η σύγκρουση σε 

θέματα που αφορούν την πολιτική, τη ψυχολογία , την οικονομία και την 

κοινωνιολογία .Κύριο χαρακτηριστικό των παιγνίων είναι η 

αλληλεπίδραση των αποφάσεων που λαμβάνονται μεταξύ των παικτών , 

οι ενέργειες ενός παίκτη καθορίζουν κατά μεγάλο ποσοστό την τύχη των 

αποφάσεων των υπόλοιπων παικτών. 

1.3 Βασικές Έννοιες Θεωρίας Παιγνίων  
 

Ορισμός έννοιας παιγνίου. 

Πρόκειται για μια κατάσταση όπου: α) Ν (>1) άτομα, 

επιχειρήσεις, κυβερνήσεις, συνδικάτα κλπ.( οι αποκαλούμενοι 

«παίκτες») κάνουν κάποιες επιλογές με στόχο ο καθένας την 

ικανοποίηση του συμφέροντος του και β) το αποτέλεσμα για κάθε 

παίκτη δεν εξαρτάται μόνο από την δική του επιλογή αλλά και από τις 

επιλογές των υπολοίπων Ν-1 παικτών.
1
 

Απαραίτητη προϋπόθεση για τη χρήση της θεωρίας παιγνίων είναι 

το πλήθος των παικτών να είναι περισσότερο από δύο. Ως «παίκτης» 

ενός παιγνίου μπορεί να είναι ένα φυσικό πρόσωπο μία οργάνωση ή ένα 

κράτος. Στόχος κάθε παίκτη μέσα σε ένα πρόβλημα παιγνίου είναι μετά 

την αξιολόγηση της κατάστασης στην οποία βρίσκεται να 

χρησιμοποιήσει όλα εκείνα τα μέσα που θα παρεμποδίσουν τον 

αντίπαλο παίκτη να βρεθεί σε πλεονεκτική θέση. Η έκβαση κάθε 

προβλήματος παιγνίου εξαρτάται από την ικανότητα-προσόντα του κάθε 

                                                           
1
 Γιάνης Βαρουφάκης ,2007 «Θεωρία Παιγνίων» - Η θεωρία που φιλοδοξεί να ενοποιήσει τις 

κοινωνικές επιστήμες – Εκδόσεις Gutenberg –Γιώργος & Κώστας Δάρδανος. 
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παίκτη, την εναλλακτική στρατηγική και την τύχη και είναι πάντα 

κέρδος ή απώλεια. 

Η αναπαράσταση των παιγνίων γίνεται με δύο τρόπους: 

1. Κανονική μορφή μήτρας. 

2. Αναλυτική μορφή μέσω δέντρου. 

Κανονική μορφή μήτρας: Η συνηθέστερη μορφή απεικόνισής παιγνίων 

γίνεται με την μορφή μήτρας. Σε κάθε γραμμή της μήτρας τοποθετείται 

η στρατηγική του πρώτου παίκτη ενώ σε κάθε στήλη η στρατηγική του 

δεύτερου παίκτη. Σε περίπτωση όπου οι παίκτες είναι περισσότεροι από 

δύο τότε αυξάνονται και οι διστάσει της μήτρας. 

Αναλυτική μορφή μέσω δέντρου: Η αναλυτική απεικόνισή μέσω 

δέντρο δίνει μια επιπλέον δυνατότητα για εμφάνιση όλων των 

λεπτομερειών που έχουν να κάνουν με τις αλληλεπιδράσεις των 

παικτών. 

Ενέργειες ορίζονται όλες οι πιθανές κινήσεις που κάνει ένας παίκτης 

κατά τη διάρκεια ενός παιγνίου. 

 

Ισορροπία κατά Nash 

Ο βραβευμένος με Νόμπελ Οικονομικών John Forbes Nash ήταν 

αυτός ο οποίος πρόσθεσέ στη θεωρία παιγνίων την σπουδαία ισορροπία 

κατά Nash. 

Στην ισορροπία κατά Nash κάθε παίκτης επιλέγει μια στρατηγική 

που του δίνει την υψηλότερη απόδοση, με δεδομένες τις στρατηγικές 

των άλλων παικτών που συμμετέχουν στο παίγνιο.
2
 

Ο ρόλος της στρατηγικής στα παίγνια. 

                                                           
2
 D.Besanko – R.Braeutigam, 2008, Μικροοικονομική , Εκδόσεις Gutenberg  
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Με τον όρο στρατηγική νοείται το σχέδιο που δημιουργείται από 

έναν παίκτη ώστε να υπερισχύσει ενάντια στους υπόλοιπους 

ανταγωνιστές-αντιπάλους. Με τον όρο στρατηγικές κινήσεις νοούνται 

όλες εκείνες οι ενέργειες που κάνει ένας παίκτης κατά την αρχή του 

παιγνίου με τις οποίες αλλάζει η δικιά του συμπεριφορά αλλά και των 

αντιπάλων του. 

 Οι κατηγορίες των στρατηγικών είναι: 

1. Αμιγής και μικτές  

2. Αυστηρά Κυρίαρχες και Ασθενώς κυρίαρχες. 

3. Κυριαρχούμενες 

Αμιγής και μικτές Στρατηγικές: Οι αμιγής στρατηγικές αφορούν τις 

κινήσεις εκείνες όπου επιλέγονται δίχως τη χρήση κανόνων 

πιθανοτήτων. Οι μικτές στρατηγικές βασίζονται σε έναν κανόνα 

επιλογής βάσει της αποτίμησης της πιθανότητας που θα επιφέρει τη 

νίκη. Ορισμένα παίγνια δεν έχουν ισορροπία κατά Nash στις αμιγής 

στρατηγικές, αυτό δεν συμβαίνει όμως και στις μικτές στρατηγικές όπου 

υπάρχει τουλάχιστον μια ισορροπία κατά Nash.  

Αυστηρά Κυρίαρχες Στρατηγικές: Μια στρατηγική ονομάζεται 

αυστηρά κυρίαρχη όταν είναι καλύτερη από οποιαδήποτε άλλη που θα 

μπορούσε να επιλέξει ο παίκτης, ανεξάρτητα από τη στρατηγική που θα 

επιλέξει ο αντίπαλος παίκτης. Η επιλογή της κυρίαρχης στρατηγικής σε 

ένα ταυτόχρονο παίγνιο επιφέρει πάντα κέρδος. Επίσης η κατοχή μιας 

κυρίαρχης στρατηγικής σημαίνει ότι είναι παράλληλα και ισορροπία 

κατά Nash.Πολλά είναι τα παίγνια όπου δεν προσφέρουν κυρίαρχες 

στρατηγικές. 
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Ασθενώς Κυρίαρχες Στρατηγικές: Ασθενώς κυρίαρχη στρατηγική 

είναι η στρατηγική , η οποία δίνει σε κάθε παίκτη τουλάχιστον εξίσου 

καλή απόδοση με κάθε άλλη διαθέσιμη στρατηγική. 

Κυριαρχούμενες Στρατηγικές: Μια κυριαρχούμενη στρατηγική είναι 

το αντίθετο μιας κυρίαρχης στρατηγικής. Δηλαδή μια στρατηγική 

ονομάζεται κυριαρχούμενη όταν ο παίκτης έχει στην διάθεση του μια 

άλλη στρατηγική με υψηλότερη απόδοση , ανεξάρτητα από τις κινήσεις 

του αντιπάλου. Στην περίπτωση όπου ο παίκτης έχει περισσότερες από 

δύο στρατηγικές τότε μπορεί ένας παίκτης να έχει μόνο κυριαρχούμενες 

στρατηγικές και καμία κυρίαρχη. Σε αντίθετη περίπτωση όπου υπάρχουν 

μόνο δύο στρατηγικές, τότε μια εκ των οποίον θα είναι κυρίαρχη και η 

άλλη κυριαρχούμενη. Σε ένα παίγνιο όπου κανένας παίκτης δεν έχει μια 

κυρίαρχη στρατηγική, η εύρεση των κυριαρχούμενων στρατηγικών 

ορισμένες φορές βοηθάει στον εντοπισμό της ισορροπίας κατά Nash. 

Ορισμένοι βασικοί τύποι παιγνίων είναι: 

1. Μηδενικού αθροίσματος 

2. Διαδοχικά ή ταυτόχρονα παίγνια.  

3. Επαναλαμβανόμενα παίγνια . 

4. Παίγνια Συνεργασίας ή μη Συνεργασίας. 

 

Παίγνια Μηδενικού αθροίσματος: Τα παίγνια μηδενικού αθροίσματος 

είναι ο πιο απλός τύπος παιγνίων, όπου ο ένας παίκτης κερδίζει ενώ ο 

αντίπαλος παίκτης χάνει. Για αυτό το λόγο το άθροισμα των 

αποτελεσμάτων είναι μηδέν διότι το κέρδος του ενός είναι η απώλεια 

του άλλου. 

Παίγνια διαδοχικών κινήσεων: Αφορούν τα παίγνια εκείνα όπου 

περιλαμβάνουν στρατηγικές που διεξάγονται μέσα από διαδοχικές και 
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εναλλασσόμενες κινήσεις των παικτών. Διαδοχικές κινήσεις θα 

μπορούσε να είναι οι κινήσεις σε ένα παιχνίδι σκάκι. Επιπλέον, οι 

επιλογές ενός παίκτη επηρεάζουν τόσο τις μελλοντικές εναλλακτικές του 

ίδιου του παίκτη όσο και των αντιπάλων του. Τέλος, σημαντική είναι 

πρώτη και η τελευταία κίνηση. 

Η απεικόνιση αυτών των παιγνίων επιτυγχάνεται με την 

προσομοίωση τους με ένα δέντρο (game tree) , στο οποίο απεικονίζονται 

οι διαφορετικές στρατηγικές που μπορεί να εφαρμόσει κάθε παίκτης σε 

ένα παίγνιο, καθώς επίσης και η σειρά με την οποία γίνεται η επιλογή 

αυτών των στρατηγικών. Το δέντρο αποτελείται από τα παρακάτω 

δομικά μέρη: 

 Κόμβος αφετηρίας-έναρξης  

 Κόμβοι απόφασης 

 Τερματικός κόμβος  

 Κλάδους 

 

Μια μέθοδος επίλυσης παιγνίων μέσα από ένα δέντρο είναι η 

αντίστροφη εισαγωγή. Με τον όρο αντίστροφή εισαγωγή νοείται η 

διαδικασία εκείνη όπου η επίλυση ξεκινάει από το τέλος του δέντρου 

του παιγνίου και εντοπίζεται η βέλτιστη απόφαση που θα λάβει ο 

παίκτης σε κάθε ένα σημείο λήψης απόφασης. 

 

Παίγνια ταυτόχρονων κινήσεων: Σε αυτού του τύπου παίγνιων λόγο 

της ταυτόχρονης δράσης δεν υπάρχει δυνατότητα αναμονής της κίνησης 

του αντιπάλου. Σε αυτές τις περιπτώσεις ο παίκτης παίρνει αποφάσεις 

δίχως να γνωρίζει τις αποφάσεις του αντιπάλου αλλά δεν σταματά να 

υπολογίζει τις επιλογές που έχεις την διάθεση του ο αντίπαλος. 

Ο τρόπος επίλυσης τέτοιων προβλημάτων είναι η διαγραμματική 

περιγραφή, η οποία περιλαμβάνει πίνακα με τις ενδεχόμενες αποδόσεις. 
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Για παράδειγμα ταυτόχρονες κινήσεις είναι οι προσφορές που γίνονται 

για παράδειγμα σε ένα διαγωνισμό για την αγορά κάποιου εκθέματος. 

 

Επαναλαμβανόμενα παίγνια :Επαναλαμβανόμενα ονομάζονται τα 

παίγνια εκείνα που παίζονται περισσότερες από μια φορές. Υπάρχουν 

δύο υποκατηγορίες τέτοιων παιγνίων, αυτά που ολοκληρώνονται μετρά 

από έναν πεπερασμένο αριθμό γύρων και τα παίγνια που άπειρων γύρων 

.Ως γύρος ορίζεται η κάθε επανάληψη του παιγνίου. Η συμπεριφορά των 

παικτών σε κάθε παίγνιο είναι τελείως διαφορετική. Επίσης μετά το 

πέρας κάθε γύρου οι παίκτες ενημερώνονται για τις κινήσεις των 

αντιπάλων παικτών. Ένα παίγνιο μπορεί να εμπείρως 

επαναλαμβανόμενο για λόγους όπως η υπομονή των παικτών, η συχνή 

επικοινωνία μεταξύ τους, ο εύκολος εντοπισμός της εξαπάτησης και το 

όφελος το οποίο μπορεί να είναι σχετικά μικρό. 

 

Παίγνια Συνεργασίας ή μη Συνεργασίας: Με τον όρο συνεργατικά 

παίγνια νοείται η συνεργασία μεταξύ των παικτών. Η συνεργασία αυτή 

δεν είναι άτυπη που σημαίνει ότι υπάρχουν δεσμεύσεις για την 

αποτροπή των παραβιάσεων. Σε αντίθετη περίπτωση σε παίγνια μη 

συνεργασίας δεν υπάρχει δέσμευση μεταξύ των παικτών, οι οποίο 

αγωνίζονται για προσωπικό όφελος και μόνο. 

Ο ρόλος της πληροφορίας στα παίγνια. 

Πληροφορία είναι κάθε γνωστικό στοιχείο που προέρχεται από την 

επεξεργασία δεδομένων. Οι πληροφορίες είναι ιδιαίτερα σημαντικές σε 

ένα παίγνιο διότι καθορίζουν κατά μεγάλο ποσοστό τις κινήσεις του 

κάθε παίκτη. 

Το είδος της πληροφόρησης σε ένα παίγνιο μπορεί να είναι: 

1. Τέλεια ή ατελής.  
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2. Πλήρης ή ελλιπής. 

Τέλεια ή ατελής Πληροφόρηση: Στα παίγνια τέλειας πληροφόρησης ο 

παίκτης κατέχει τέλεια πληροφόρηση για τις κινήσεις του αντιπάλου 

κατά τη διάρκεια όλου του παιγνίου από την αρχή έως και το τέλος. Σε 

αντίθετη περίπτωση στην ατελή πληροφόρηση ο παίκτης δεν γνωρίζει 

καμία κίνηση του αντιπάλου που έχει γίνει στο παρελθόν του παιγνίου.  

Πλήρης ή ελλιπής Πληροφόρηση: Στην περίπτωση της πλήρης 

πληροφόρησης ο παίκτης γνωρίζει τα πλήρη χαρακτηριστικά του 

αντιπάλου του. Ενώ στην περίπτωση της ελλιπής πληροφόρησης ο 

παίκτης δεν γνωρίζει με απόλυτη ακρίβεια τα χαρακτηριστικά του 

αντιπάλου του. Το μόνο που είναι γνωστό είναι ή ιστορία των παικτών 

αλλά όχι περαιτέρω χαρακτηριστικά όπως για παράδειγμα η 

τεχνογνωσία της αντίπαλης επιχείρησης.  

Θεωρία: Οπισθογενής Επαγωγή. 

Η μέθοδος της οπισθογενής επαγωγής χρησιμοποιείται για την επίλυση 

παιγνίων διαδοχικών κινήσεων με πλήρη πληροφόρηση. Λόγω του ότι 

υπάρχει πλήρης πληροφόρηση, κάθε παίκτης προσαρμόζει την 

στρατηγική του βάσει των επιλογών του αντιπάλου του. Η εύρεση της 

ισορροπίας κατά Nash μέσω της οπισθογενής επαγωγής ξεκινάει πάντα 

από το τελευταίο στάδιο του δενδρογράμματος. 
3
 

Λύση Minimax-Maximin 

Ο όρος Minimax προστέθηκε στη θεωρία παιγνίων από της John von 

Neumann. Ο John von Neumann ο οποίος ήταν ένας από τους ιδρυτές 

της θεωρίας παιγνίων παρουσίασε το 1928 τη λύση Minimax που αφορά 

μια ευρεία τάξη παιγνίων. Η λύση αυτή αποσκοπεί στη διευκόλυνση 

λήψης αποφάσεων όπου οι παίκτες λαμβάνουν αποφάσεις ώστε να 

                                                           
3
 Robert Gibbons, 2009, Εισαγωγή στη Θεωρία Παιγνίων, Εκδόσεις Gutenberg. 
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μειωθεί το πιθανό κέρδος των αντιπάλων τους. Αντίθετα, ο όρος 

Maximin σημαίνει μεγιστοποίηση της ελάχιστης απόδοσης, ο όρος 

αυτός χρησιμοποιείται σε παίγνια μη μηδενικού αθροίσματος.
4
 

ΚΕΦΑΛΑΙΟ ΔΕΥΤΕΡΟ 

ΕΙΣΑΓΩΓΗ ΣΤΟ ΠΡΟΓΡΑΜΜΑ GAMBIT 
 

2.1 Ιστορική Αναδρομή 
 

Το πρόγραμμα Gambit δημιουργήθηκε στα μέσα του 1980 από 

τον Richard McKelvey στο ινστιτούτο τεχνολογίας της California. Ο 

αρχικός προγραμματισμός έγινε σε γλώσσα Basic ενώ το γραφικό 

περιβάλλον ήταν ιδιαίτερα απλό. Με τη βοήθεια του Bruce Bell tο 1990 

ο αρχικός κώδικας του προγράμματος μετατράπηκε σε γλώσσα C και 

δόθηκε στο κοινό το έτος 1991 και 1992 με έκδοση 0.13. 

Ένα σημαντικό βήμα στην εξέλιξη του Gambit ήταν η βράβευση 

του από το Εθνικό Ίδρυμα Επιστημών (NSF) της Αμερικής το 1994, με 

τους McKelvey και McLennan ως κύριους ερευνητές και κύριο 

προγραμματιστή τον Theodore Turocy. Η δωρεά επιχορήγησε 

εξολοκλήρου τον επανασχεδιασμό του κώδικα του Gambit σε 

Αντικειμενοστραφή γλώσσα προγραμματισμού C++. Το γραφικό 

περιβάλλον έγινε συμβατό με πλατφόρμες με την χρήση των 

wxWidgets. Η έκδοση 0.94 του Gambit κυκλοφόρησε στα τέλη του 

καλοκαιριού του 1994, ακολούθησε η έκδοση 0.96 το 1999 και η 

έκδοση 0.97 το 2002. Πλεον από το 2011 μέχρι και το 2014 έχουν 

κυκλοφορήσει και άλλες εκδόσεις του προγράμματος με τελευταία την 

έκδοση 14.1.0. Αρκετοί όμως ήταν και οι φοιτητές που συνέβαλλαν 

                                                           
4
 Γιάνης Βαρουφάκης ,2007 «Θεωρία Παιγνίων» - Η θεωρία που φιλοδοξεί να ενοποιήσει τις 

κοινωνικές επιστήμες – Εκδόσεις Gutenberg –Γιώργος & Κώστας Δάρδανος. 
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στην προσπάθεια του προγραμματισμού, της δοκιμής της λειτουργίας 

του προγράμματος ακόμα και στην προσθήκη νέων λειτουργιών. 

Την ίδια περίοδο , ο Bernhard von Strengel από το London School 

of Economics , έκανε μια σημαντική συμβολή στην εφαρμογή της 

μεθόδου ακολουθίας που αφορούσε εκτεταμένα παιχνίδια παιγνίων δύο 

παικτών, καθώς επίσης και στην προσθήκη του κώδικα όπου εντοπίζει 

τις ισορροπίες σε στρατηγικά παιχνίδια δύο ατόμων καθώς και άλλες 

συμβουλές σχετικά με την εφαρμογή και την αρχιτεκτονική του δομή. 

Η ανάπτυξη από τα μέσα του 2000 επικεντρώθηκε σε δύο 

αντικείμενα. Πρώτον, το γραφικό περιβάλλον υλοποιήθηκε ξανά και 

εκσυγχρονιστικέ, με στόχο την τήρηση των άριστων αρχών σχεδιασμού 

αλληλεπίδρασης, ιδιαίτερα σε ότι ό,τι αφορά στη διευκόλυνση της 

καμπύλης μάθησης των νέων χρηστών του Gambit , οι οποίοι 

χρησιμοποιούν για πρώτη φορά την θεωρία παιγνίων. Δεύτερον, η 

εσωτερική αρχιτεκτονική του Gambit ανανεώθηκε ώστε να αυξηθεί η 

συμβατότητα μεταξύ εκείνων των εργαλείων που παρέχονται από το 

Gambit και εκείνων που έχουν συνταχθεί ανεξάρτητα. 

Το Gambit έχει συμμετάσχει στο πρόγραμμα Google Summer of 

Code τα καλοκαίρια του 2011 και 2012 ως οργανισμός καθοδήγησης. Η 

Python API , η οποία έγινε μέλος του Gambit 13, αναπτύχθηκε κατά τη 

διάρκεια εκείνων των καλοκαιριών, χάρη κυρίως στο έργο των Stephen 

Kunath και Alessandro Andrioni. 

2.2 Τι είναι το Gambit 
 

Το Gambit είναι ένα σύνολο εργαλείων λογισμικού που έχουν ως 

σκοπό την επίλυση μη συνεργατικών παιχνιδιών παιγνίου. Περιλαμβάνει 

ένα γραφικό περιβάλλον αλληλεπίδρασης για τη δημιουργία και 

ανάλυση γενικών παιχνιδιών σε εκτεταμένη ή στρατηγική μορφή. Η 
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γραμμή εντολών στο μενού του προγράμματος περιλαμβάνει τον 

υπολογισμό της ισορροπίας κατά Nash και άλλες έννοιες -λύσεις στα 

παιχνίδια. Επίσης υπάρχει μια σειρά από μορφές αρχείων για την 

αποθήκευση και την επικοινωνία των παιχνιδιών με άλλα εξωτερικά 

εργαλεία.  

 

2.3 Βασικά Χαρακτηριστικά του Gambit 
 

Το πρόγραμμα Gambit προσφέρει μια σειρά από χρήσιμες λειτουργίες, 

τόσο στον ερευνητή όσο και στον εκπαιδευτή. 

 Διαδραστικό γραφικό περιβάλλον Ανεξάρτητης Πλατφόρμας:  

Όλα τα χαρακτηριστικά του Gambit είναι διαθέσιμα μέσα από το 

γραφικό περιβάλλον , το οποίο λειτουργεί με πολλαπλά λειτουργικά 

συστήματα όπως Windows ,Linux και Mac OS X. Το λογισμικό 

προσφέρει ευέλικτες μεθόδους για τη δημιουργία παιχνιδιών παιγνίου 

εκτεταμένης και στρατηγικής μορφής. Προσφέρει επίσης μια 

διεπαφή για την εκτέλεση αλγορίθμων για τον υπολογισμό της 

ισορροπίας κατά Nash , καθώς και για την απεικόνιση των 

αποτελεσμάτων σε μορφή κανονική μορφή μήτρας ή σε αναλυτική 

μορφή μέσω δέντρου.  

Σημαντική είναι και η ανάλυση της δομής της κυριαρχίας των 

ενεργειών ή των στρατηγικών στο παιχνίδι παιγνίου μέσω ενός 

διαδραστικού εργαλείου.To Λογισμικό είναι εξίσου χρήσιμο και 

εξειδικευμένους ερευνητές , αλλά δίνει περισσότερη έμφαση στον να 

γίνεται κατανοητό και εύκολα προσβάσιμο σε μαθητές που 

πραγματοποιούν τα πρώτα μαθήματα πάνω στη θεωρία των παιγνίων 

. 
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 Εργαλεία στη γραμμή εντολών για τον υπολογισμό των 

ισορροπιών. 

 

Πιο προηγμένες εφαρμογές συχνά απαιτούν εκτεταμένο 

υπολογιστικό χρόνο. Όλοι οι αλγόριθμοι στο Gambit είναι 

κατηγοριοποιημένοι ως ατομικά προγράμματα στη γραμμής εντολών, 

η λειτουργία των οποίων και η παραγωγή μπορεί να 

παραμετροποιηθεί . Αυτή η δυνατότητα δίνεται από τη χρήση της 

γλώσσας προγραμματισμού C++. 

 

 Επεκτασιμότητα και διαλειτουργικότητα.  

 

Τα εργαλεία του Gambit διαβάζουν και επεξεργάζονται μορφές 

αρχείων κειμένου που είναι τεκμηριωμένα, καθιστώντας τα φορητά 

μεταξύ των διαφόρων συστημάτων και είναι σε θέση να 

αλληλοεπιδρούν με εξωτερικά εργαλεία. Επομένως, είναι εύκολο να 

επεκτείνουν τις δυνατότητες του προγράμματος , για παράδειγμα, την 

εφαρμογή μιας νέας μεθόδου για τον υπολογισμό της ισορροπίας, την 

εφαρμογή ενός υπάρχοντος πιο αποτελεσματικά, ή δημιουργώντας 

νέα εργαλεία για προγραμματισμό, δημιουργία, χειρισμό, και 

μετατροπή παιχνιδιών παιγνίου, είτε για οικονομετρική ανάλυση. 

 

2.4  Γραφικό περιβάλλον. 

 

Το γραφικό περιβάλλον του προγράμματος παρέχει στους χρήστες 

ένα ολοκληρωμένο περιβάλλον ανάπτυξης με σκοπό τη διευκόλυνση 

δημιουργίας οπτικών παιχνιδιών παιγνίου και διερεύνησης των βασικών 

στρατηγικών τους χαρακτηριστικών. Η διαδραστική κατασκευή και 

ανάλυση των μικρομεσαίων παιχνιδιών είναι ένας κύριος σκοπός του 
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γραφικού περιβάλλοντος. Αυτό συμβαίνει διότι ο χρόνος υπολογισμού 

που απαιτείται για την ανάλυση της ισορροπίας των παιχνιδιών 

αυξάνεται ραγδαία όσο μεγαλύτερο είναι το παιχνίδι .Το γραφικό 

περιβάλλον είναι ιδανικό για φοιτητές που μαθαίνουν τις βασικές αρχές 

της θεωρίας των παιγνίων, ή για τους επαγγελματίες που επιθυμούν να 

αναλύσουν πιο περίπλοκα παιχνίδια παιγνίου. 

 

2.5 Μειονεκτήματα του Gambit. 
 

Πάρα τα πλεονεκτήματα το Gambit όπως όλα τα προγράμματα 

έχει και ορισμένα μειονεκτήματα-περιορισμούς όσον αφορά την 

εκτέλεση ορισμένων εφαρμογών. Παρακάτω ακολουθεί μια περιγραφή 

των περιορισμών αυτών.  

 Αφορά παιχνίδια πεπερασμένου χρόνου μόνο. 

Λόγω της μαθηματικής δομής των πεπερασμένων παιχνιδιών 

παιγνίου, είναι δυνατόν να γράψει πολλές ρουτίνες γενικής χρήσης 

για την ανάλυση αυτών των παιχνιδιών. Έτσι, το Gambit μπορεί να 

χρησιμοποιηθεί σε μία ευρεία ποικιλία εφαρμογών της θεωρίας 

παιγνίων. Ωστόσο, τα παιχνίδια που δεν είναι πεπερασμένης μορφής, 

δηλαδή, παιχνίδια στα οποία οι παίκτες μπορούν να επιλέξουν από 

μια συνέχεια δράσεων, ή στο οποίο οι παίκτες μπορούν να έχουν μια 

συνέχεια των τύπων, δεν παραδέχονται τις ίδιες μεθόδους γενικής 

χρήσης. 

 Αφορά μη συνεργατικά παιχνίδια παίγνιου. 

Το Gambit επικεντρώνεται στην κατηγορία της θεωρίας παιγνίων 

στα οποία οι κανόνες του παιχνιδιού αναγράφονται ρητά , και στο 

οποίο οι παίκτες επιλέγουν τις δράσεις τους ανεξάρτητα από τις 
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επιλογές των αντίπαλων παικτών. Τα αναλυτικά εργαλεία του 

προγράμματος επικεντρώνονται κατά κύριο λόγο γύρω στην 

ισορροπία κατά Nash , και των συναφών εννοιών του περιορισμένου 

ορθολογισμού, όπως η απάντηση κβαντικής ισορροπίας. Αυτή τη 

στιγμή το πρόγραμμα Gambit δεν παρέχει καμία αναπαράσταση , ή 

μέθοδο για ανάλυση παιχνιδιών γραμμένα σε μορφή συνεργασίας. 

(Θα πρέπει να σημειωθεί ότι ορισμένα προβλήματα σε 

συνεταιριστική μορφή δεν πάσχουν από υπολογιστική 

πολυπλοκότητα που επιφέρει η ισορροπία κατά Nash, και έτσι θα 

μπορούσε οι έννοιες αυτές θα μπορούσε να είναι μια ενδιαφέρουσα 

μελλοντική κατεύθυνση της ανάπτυξης.) 

 Η ανάλυση μεγάλων παιχνιδιών παιγνίου μπορεί να καταστεί 

ανέφικτη ιδιαίτερα γρήγορα. 

Ενώ οι ειδικές κατηγορίες πολυπλοκότητας υπολογισμού 

ισορροπιών κατά Nash και παρόμοιες έννοιες είναι ένας τομές που 

βρίσκεται σε συνεχή έρευνα , είναι σαφές ότι, στην τυπική περίπτωση, η 

ποσότητα του χρόνου που απαιτείται για τον υπολογισμό της ισορροπίας 

αυξάνεται ταχέως ανάλογα με το μέγεθος του παιχνιδιού. Με άλλα 

λόγια, είναι αρκετά εύκολο να διατυπωθούν παιχνίδια που θα λάβει το 

Gambit ιδιαίτερα μεγάλο χρονικό διάστημα για τον υπολογισμό της 

ισορροπίας του. Υπάρχουν δύο τρόποι για να αντιμετωπιστεί αυτό το 

πρόβλημα στην πράξη. Ένας τρόπος είναι να προσδιοριστεί η καλύτερη 

προσέγγιση για την καθοδήγηση της διαδικασίας υπολογισμού της 

ισορροπίας. Ένας άλλος τρόπος είναι να ωφελιμότητα από γνωστά 

χαρακτηριστικά του παιχνιδιού για να υπάρξει μια καθοδήγηση της 

διαδικασία. Και οι δύο αυτές προσεγγίσεις αποτελούν ιδιαίτερο 

ενδιαφέρον και εμπεριέχονται στην περιοχή της ερευνάς . Αν και 

σίγουρα δεν θα είναι δυνατό να αναλυθεί κάθε παιχνίδι που κάποιος θα 
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ήθελε , υπάρχει η ελπίδα ότι θα το πρόγραμμα Gambit να συνεισφέρει 

τόσο σε αυτούς τους δύο τομείς της έρευνας, τόσο και στην διάθεση των 

αποτελεσμάτων από τις μεθόδους που προκύπτουν στους μαθητές και 

τους επαγγελματίες. 

2.6 Μορφές αρχείων. 
 

 Το λογισμικό του Gambit χειρίζεται πολλές διαφορετικές μορφές 

αρχείων για την αναπαράσταση των παιχνιδιών. Σε αυτή την υποενότητα 

περιλαμβάνεται μια σύντομη επισκόπηση των εν λόγω μορφών. 

 Το Gambit έχει για πολλά χρόνια υποστηρίξει δύο μορφές 

αρχείων για την εμφάνιση των παιχνιδιών, μια για εκτεταμένης μορφής 

παιχνίδια (συνήθως χρησιμοποιώντας το όνομα του αρχείου με 

επέκταση .efg) και μια για παιχνίδια στρατηγικής (συνήθως 

χρησιμοποιώντας το όνομα του αρχείου με επέκταση .nfg). Αυτές οι 

μορφές αρχείων αναγνωρίζεται από όλες τις εκδόσεις του. Με την 

έκδοση 2005.12.xx, το λογισμικό διαβάζει και γράφει τώρα μια νέα 

μορφή αρχείου, το οποίο αναφέρεται ως "βιβλίο εργασίας Gambit." 

Αυτή η εκτεταμένη μορφή αρχείου περιλαμβάνει όχι μόνο την 

αναπαράσταση του παιχνιδιού, αλλά και πρόσθετες πληροφορίες, 

συμπεριλαμβανομένων των παραμέτρων σε παιχνίδια μορφής δέντρου 

,την ανάθεση χρωμάτων στους παίκτες, κάθε ισορροπία ή άλλη ανάλυση 

γίνεται στο παιχνίδι, και ούτω καθεξής. Έτσι, για παράδειγμα, το αρχείο 

βιβλίου εργασίας μπορεί να χρησιμοποιηθεί για την αποθήκευση της 

ανάλυση του παιχνιδιού . Τα αρχεία αυτά έχουν επέκταση .gbt  

Το λογισμικό αναγνωρίζει αρχεία σε όλες τις τρεις μορφές: .gbt, 

.efg, και .nfg. Οι εντολές "Αποθήκευση" και "Αποθήκευση ως", όμως, 

αποθηκεύουν πάντα σε μορφή (.gbt) . Για να γίνει αποθήκευση του 

παιχνιδιού σε εκτεταμένη (.efg) ή στρατηγική μορφή (.nfg), θα πρέπει να 
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επιλεγεί « Export» από την επιλογή «File» στο κεντρικό μενού του 

προγράμματος. Αυτό είναι χρήσιμο στη διασύνδεση με τις παλαιότερες 

εκδόσεις του Gambit , με άλλα εργαλεία που διαβάζουν και να γράφουν 

τα έντυπα αυτά. Οι χρήστες που ενδιαφέρονται κυρίως για τη χρήση του 

Gambit μόνο μέσω του γραφικού περιβάλλοντος ενθαρρύνονται να 

χρησιμοποιούν αρχεία με επέκταση (.gbt) . 

Δεδομένου ότι είναι μια νέα μορφή, η μορφή βιβλίου εργασίας 

Gambit είναι ακόμα υπό ανάπτυξη και μπορεί να αλλάξει σε 

λεπτομέρειες. Εννοείται ότι οι νεότερες εκδόσεις του γραφικού 

περιβάλλοντος θα εξακολουθούν να είναι σε θέση να διαβάζουν τα 

αρχεία από το βιβλίο εργασίας γραμμένο σε παλαιότερες μορφές. 

2.7 Εγκατάσταση του προγράμματος. 
 

To πρόγραμμα Gambit λειτουργεί σε ετήσιο κύκλο, συγκεκριμένα 

μια νέα έκδοση κυκλοφορεί κάθε Αύγουστο. Ο μεγαλύτερος αριθμός 

έκδοσης είναι ίσος με τα δύο τελευταία ψηφία του έτους κατά το οποίο 

η έκδοση είναι σταθερή. Η τρέχουσα σταθερή έκδοση του 

προγράμματος είναι η 14.1.0 , η οποία έγινε διαθέσιμη τον Αύγουστο 

του 2014. Η λήψη του μπορεί να γίνει από το Sourceforge . Ο πλήρης 

πηγαίος κώδικας είναι διαθέσιμος , ο οποίος είναι μεταγλωττισμένος 

ώστε να λειτουργεί και σε συστήματα Microsoft Windows και Mac OS 

X 10.8.  

Η σταθερή έκδοση είναι κατάλληλη για τη διδασκαλία και την χρήση 

από τους σπουδαστές καθώς επίσης και για τους επαγγελματίες που 

απαιτούν μια έκδοση με API( Διεπαφή προγραμματισμού εφαρμογών). 

Επιπλέον εκδόσεις του Gambit 13 θα κυκλοφορήσουν για τη συντήρηση 

και τη διόρθωση σφαλμάτων. 
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Η νέα σειρά ανάπτυξης/έρευνας Gambit 14 που κυκλοφορεί 

απευθύνεται σε προγραμματιστές , ερευνητές που εργάζονται σε 

αλγορίθμους που έχουν να κάνουν με τη θεωρία παιγνίων , γενικότερα 

σε εκείνους που απαιτούν τις τελευταίες εφαρμογές για το ερευνητικό 

τους έργο. 

Δίνεται επίσης δυνατότητα εγκατάστασης παλαιότερων εκδόσεων του 

προγράμματος μέσα από την ιστοσελίδα : 

http://sourceforge.net/projects/gambit/files  

 

 

 

ΚΕΦΑΛΑΙΟ ΤΡΙΤΟ 

ΑΝΑΛΥΣΗ ΠΡΟΓΡΑΜΜΑΤΟΣ  
 

Το γραφικό περιβάλλον του Gambit παρέχει ένα "ολοκληρωμένο 

περιβάλλον ανάπτυξης" με σκοπό τη διευκόλυνση της οπτικής 

δημιουργίας παιχνιδιών παιγνίου και τη διερεύνηση των τα βασικών 

στρατηγικών χαρακτηριστικών τους. 

Κύριος στόχος του γραφικού περιβάλλοντος είναι η διαδραστική 

κατασκευή και η ανάλυση των μικρομεσαίων παιχνιδιών , διότι όπως ο 

χρόνος υπολογισμού που απαιτείται για την ανάλυση της ισορροπίας 

των παιχνιδιών αυξάνεται ραγδαία ανάλογα με το μέγεθος του 

παιχνιδιού. Το γραφικό περιβάλλον είναι ιδανικό για φοιτητές 

μαθαίνουν τις βασικές αρχές της θεωρίας των παιγνίων, ή για τους 

επαγγελματίες που επιθυμούν να επιλύσουν πιο εξειδικευμένα παιχνίδια 

. 

3.1 Γενική διάταξη κύριου παραθύρου. 
 

http://sourceforge.net/projects/gambit/files
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Το πλαίσιο που παρουσιάζει ένα παιχνίδι αποτελείται από δύο 

κύρια τμήματα, τον κύριο πίνακα και στη δεξιά μεριά τη γραφική 

παρουσίαση του παιχνιδιού. Όπως φαίνεται και στην παρακάτω εικόνα 

στην περίπτωση αυτή η απεικόνιση γίνεται με τη μορφή δέντρου. Στην 

αριστερή μεριά του παραθύρου εμφανίζονται οι δύο παίκτες Player 1 και 

Player 2 , όπου ο καθένας έχει και από ένα διαφορετικό χρώμα για τον 

συμβολισμό των κινήσεων και των απολαβών. Το χρώμα καθώς και το 

όνομα κάθε παίκτη μπορούν να αλλάξουν κάνοντας διπλό κλικ στο 

χρώμα και στο όνομα αντίστοιχα. 

 

 

 

Η γραμμή εντολών περιλαμβάνει τις παρακάτω επιλογές: 

 

 

 File: περιλαμβάνονται λειτουργίες όπως η δημιουργία νέου 

παιχνιδιού εκτεταμένης ή στρατηγικής μορφής, άνοιγα ήδη 
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υπάρχοντος παιχνιδιού, αποθήκευση, μετατροπή του 

αποθηκευμένου αρχείου σε διαφορετικές εκδόσεις :(Bmp, 

Jpeg,Png ,PostScript Svg) εκτύπωση, κλείσιμο και έξοδος από το 

πρόγραμμα. 

 Edit: περιλαμβάνονται λειτουργίες όπως αναίρεση κάποιας 

κίνησης, προσθήκη νέου παίκτη, προσθήκη κίνησης, προσθήκη 

δράσης, επαναφορά , διαγραφή υπόδεντρου , διαγραφή γονέα 

όσον αφορά τους κόμβους, διαγραφή απόδοσης, κόμβος, κίνηση 

και τέλος υπάρχει μια επιλογή Game (παιχνίδι) όπου γίνεται 

επεξεργασία στην ονομασία και το περιεχόμενο του παιχνιδιού. 

 View  : περιλαμβάνονται λειτουργίες όπως εμφάνιση προφίλ 

στρατηγικών του παιχνιδιού και εναλλαγές στην μορφή του 

παιχνιδιού σε δέντρο και προβολή στρατηγικού παιχνιδιού. 

 Format : περιλαμβάνονται λειτουργίες όπως η προβολή διάταξης 

ενός παιχνιδιού σε μορφή δέντρου, η επεξεργασία των κόμβων 

του καθώς και επιλογές όσον αφορά την προβολή των 

διαγραμμάτων στο πρόγραμμα. 

 Tools: περιλαμβάνονται λειτουργίες όπως η εμφάνιση νέας 

γραμμής εργαλείων για τον υπολογισμό των κυρίαρχων 

στρατηγικών καθώς επίσης και δυνατότητα εύρεσης ισορροπιών 

και κβαντικών ισορροπιών. 

 Help: εμπεριέχονται γενικές πληροφορίες για το πρόγραμμα 

Gambit. 

 

Δύο επιπλέον πάνελ είναι διαθέσιμα στο πρόγραμμα: 

1. Επιλέγοντας από το κεντρικό μενού Tools ->Dominance , 

εναλλάσσεται η εμφάνιση και εμφανίζεται μια νέα γραμμή εργαλείων 

σε όλη τη κορυφή του παραθύρου. Αυτή η γραμμή εργαλείων ελέγχει 

την ένδειξη και την εξάλειψη των δράσεων ή των κυρίαρχων 
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στρατηγικών. Αυτή η νέα γραμμή εργαλείων χρησιμοποιείται στη 

διερεύνηση των κυριαρχούμενων στρατηγικών και δράσεων. 

 

  

 

2.  Επιλέγοντας View-> Profiles ή κάνοντας κλικ στο εικονίδιο View the 

List of Computed strategy profiles, εναλλάσσεται η λίστα της 

εμφάνισης των υπολογιζόμενων προφίλ στρατηγικής για το παιχνίδι. 

 

 

3.2  Αποδόσεις και πιθανότητες στο Gambit. 
 

Οι αποδόσεις κάθε παιχνιδιού μπορούν να αναγραφούν ως 

δεκαδικοί αριθμοί. Το Gambit υποστηρίζει την εκπροσώπηση των 

εξοφλήσεων μέσω ορθολογικών αριθμών. Για παράδειγμα σε 

οποιαδήποτε θέση στην οποία μπορεί να εμφανιστεί μια απόδοση ή το 

αποτέλεσμα ενός εκτεταμένου παιχνιδιού ή μια κατοχύρωση απόδοσης 

σε ένα στρατηγικό παιχνίδι, το αποτέλεσμα ένα δέκατο μπορεί να 

αναγραφεί είτε ως .1 ή 1/0. 
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Το πλεονέκτημα αυτής της μορφής είναι ότι σε ορισμένες 

περιπτώσεις το Gambit μπορεί να είναι σε θέση να υπολογίζει ακριβώς 

τις ισορροπίες. Επιπλέον, ορισμένες μέθοδοι εύρεσης ισορροπιών 

δημιουργούν καλές αριθμητικές προσέγγισες για τα σημεία ισορροπίας. 

Για τις μεθόδους αυτές οι υπολογισμένες ισορροπίες αποθηκεύονται σε 

μορφή κινητής υποδιαστολής. Για να γίνει του αριθμού των δεκαδικών 

ψηφίων που εμφανίζεται για αυτά τα προφίλ , πρέπει να γίνει κλικ 

αύξησης δεκαδικών ψηφίων. Για να γίνει αντίστοιχα μείωση των 

δεκαδικών ψηφίων θα πρέπει να γίνει κλικ στο εικονίδιο μείωσης 

δεκαδικών ψηφίων. Η αύξηση ή η μείωση των δεκαδικών ψηφίων που 

εμφανίζονται στο προφίλ στρατηγικού υπολογισμού δεν θα έχει κανένα 

αποτέλεσμα στο τελικό αποτέλεσμα του παιχνιδιού. 

3.3 Παιχνίδια παιγνίου εκτεταμένης μορφής.  

 

Το γραφικό περιβάλλον του προγράμματος προσφέρει ένα 

ευέλικτο σύνολο εργασιών για τη δημιουργία και επεξεργασία γενικών 

παιχνιδιών παιγνίου εκτεταμένης μορφής. 

 

3.3.1  Δημιουργία ενός νέου παιχνιδιού εκτεταμένης 

μορφής. 
 

Η δημιουργία ενός νέου παιχνιδιού εκτεταμένης μορφής γίνεται 

μέσα από τις εντολές File -> New-> Extensive game ή κάνοντας κλικ 

στο εικονίδιο «new extensive game». 
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Το εκτεταμένο παιχνίδι που δημιουργείται είναι ένα απλής 

μορφής παιχνίδι με δύο παίκτες, που ονομάζονται από προεπιλογή του 

προγράμματος Player 1 και Player 2. 

 

 Επιπλέον, τα εκτεταμένα παιχνίδια έχουν μια επιλογή Chance , η 

οποία χρησιμοποιείται για την αναπαράσταση τυχαίων γεγονότων που 

δεν ελέγχονται από τις στρατηγικές των παικτών στο παιχνίδι όπως για 

παράδειγμα η ρίψη ενός ζαριού. 

 

 

3.3.2  Προσθήκη κινήσεων.  
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Υπάρχουν δύο επιλογές για την προσθήκη κινήσεων σε μια 

γραφική απεικόνιση τύπου δέντρου: Drag and drop και Insert move 

dialog. 

 

Η προσθήκη των κινήσεων που γίνεται με τη χρήση του drag and 

drop, γίνεται από το παράθυρο της λίστας των παικτών, σέρνοντας 

το εικονίδιο που βρίσκεται στα αριστερά του παίκτη ,το οποίο θα 

μπορεί να μετακινηθεί σε κάθε τερματικό κόμβο του δέντρου. Το 

δέντρο θα επεκταθεί με μια κίνηση για αυτόν τον παίκτη , με δύο 

δράσεις σε μία κίνηση. Η προσθήκη μια κίνησης για τον «παίκτη» 

Chance (πιθανότητα), γίνεται με τον ίδιο τρόπο σύροντας το 

εικονίδιο Dice (ζάρια)  που εμφανίζεται στα αριστερά του παίκτη 

Chance στη λίστα των παικτών. Για τον «παίκτη» πιθανότητα Chance 

Player οι δύο δράσεις που δημιουργούνται θα πρέπει να δοθεί σε 

κάθε μία ξεχωριστά μια πιθανότητα με μισή βαρύτητα, όπως 

φαίνεται και στην παρακάτω εικόνα.  

 

Εάν η επιθυμητή κίνηση έχει περισσότερες από δύο δράσεις, μπορούν 

να προστεθούν συμπληρωματικές ενέργειες σέρνοντας το εικονίδιο του 

ίδιου παίκτη στον κόμβο της κίνησης. 
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1. Κάνοντας κλικ σε κάθε τερματικό κόμβο στο δέντρο και 

επιλέγοντας Edit ->Insert move , εμφανίζεται το παράθυρο εισαγωγής 

κίνησης.  

 

a) Ο πρώτος έλεγχος καθορίζει τον παίκτη που θα κάνει την κίνηση. Η 

κίνηση αυτή μπορεί να ανατεθεί σε έναν νέο παίκτη.  

b) Ο δεύτερος παίκτης επιλέγει τις πληροφορίες με τις οποίες θα 

προστεθεί η νέα κίνηση.  

c) Ο τρίτος έλεγχος ορίζει τον αριθμό των δράσεων. Αυτός ο έλεγχος 

είναι απενεργοποιημένος εκτός αν ο δεύτερος έλεγχος έχει οριστεί 

σε ένα νέο σύνολο πληροφοριών Αλλιώς, ρυθμίζεται αυτόματα με 

τον αριθμό των ενεργειών στο επιλεγμένο σύνολο πληροφοριών. 

 

Οι δύο παραπάνω μέθοδοι προσθήκης κινήσεων μπορούν να είναι 

χρήσιμοι σε διαφορετικά πλαίσια. Η προσέγγιση drag and drop είναι 

λίγο πιο γρήγορη στη χρήση , ειδικά κατά τη δημιουργία δέντρων που 

έχουν λίγες δράσεις σε κάθε κίνηση. Η προσέγγιση εισαγωγής κίνησης 

μέσω των εντολών Edit ->Insert move, είναι λίγο πιο ευέλικτη δίνοντας 

τη δυνατότητα εισαγωγής μιας κίνηση σε ένα απροσδιόριστο παίκτη, μια 

κίνηση μπορεί να μπορεί να προστεθεί σε ένα υπάρχον σύνολο 

πληροφοριών και μία κίνηση μπορεί να δοθεί άμεσα σε περσότερες από 

δύο δράσεις. 
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3.3.3 Αντιγραφή και μετακίνηση υποδένδρων. 

 

Πολλά παιχνίδια παιγνίου έχουν εκτεταμένες δομές που 

εμφανίζονται σε πολλά μέρη του δέντρου. Συχνά είναι αποτελεσματικό 

να δημιουργείται μια φορά η δομή και στη συνέχεια να γίνεται 

αντιγραφή του όπου αλλού απαιτείται. 

Το Gambit παρέχει μια ιδιαίτερα βολική δυνατότητα για αυτή τη 

λειτουργία. Κάνοντας κλικ σε κάθε μη τερματικό κόμβο και σύροντας 

το σε κάθε τερματικό κόμβο υλοποιείται μια λειτουργία μετακίνησης , η 

οποία μετακινεί ολόκληρο το υπόδενδρο στο αρχικό μη τερματικό 

κόμβο στο τερματικό. Όταν η ίδια λειτουργία γίνεται κρατώντας 

πατημένο του πλήκτρο Ctrl του πληκτρολόγιου, τότε μετατρέπεται σε 

λειτουργία αντιγραφής . Ολόκληρο το υπόδενδρο στον αρχικό κόμβο 

αντιγράφεται ξεκινώντας από τον τερματικό κόμβο. 

Υποστηρίζεται επίσης και η δυνατότητα αντιγραφής υπόδενδρου 

σε ένα τερματικό κόμβο του υπόδενρου . Σε αυτή την περίπτωση, η 

λειτουργία της αντιγραφής διακόπτεται όταν φθάσει στο τερματικό 

κόμβο, για να αποφευχθεί ένας άπειρος βρόγχος. Έτσι αυτό το 

χαρακτηριστικό μπορεί επίσης να είναι χρήσιμο για τη δημιουργία 

παιχνιδιών πολλαπλών σταδίων. 

3.3.4  Αφαίρεση μερών από παιχνίδι μορφής δέντρου.  
Στα παιχνίδια εκτεταμένης μορφής υποστηρίζονται δύο 

λειτουργίες διαγραφής.  

 Για να γίνει διαγραφή ολόκληρου υπόδενδρου σε ένα κόμβο , 

θα πρέπει να γίνει κλικ στο κόμβο αυτό και συνέχεια Edit -> 

Delete subtree. 
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 Για να γίνει διαγραφή μεμονωμένης κίνησης στο παιχνίδι, θα 

πρέπει να γίνει κλικ σε ένα από τα «παιδία» του κόμβου και 

στη συνέχεια Edit -> Delete Parent. Αυτή η λειτουργία 

διαγράφει το μητρικό κόμβο , καθώς και όλα τα παιδία του 

εκτός από τον επιλεγμένο κόμβο. Ο επιλεγμένος κόμβος παιδί 

παίρνει τώρα τη θέση του μητρικού κόμβου στο δέντρο. 

3.3 Διαχείριση πληροφοριών 
 

ΤΟ Gambit παρέχει διάφορες μεθόδους για τη βοήθεια της 

διαχείρισης της δομής των πληροφοριών  σε ένα παιχνίδι εκτεταμένης 

μορφής. 

Κατά τη δημιουργία ενός δέντρου, μπορούν να εισαχθούν νέες 

πληροφορίες σε μια δεδομένη στιγμή , χρησιμοποιώντας την επιλογή 

Insert Move (εισαγωγή κίνησης). Επιπλέον, νέες κινήσεις μπορούν να 

εισαχθούν με την επιλογή drag and drop , κρατώντας πατημένο το 

πλήκτρο Shift και σέρνοντας έναν κόμβο στο δέντρο. Κατά τη διάρκεια 

της λειτουργίας της μεταφοράς, ο κέρσορας μετατρέπεται σε εικονίδιο 

κίνησης. Ρίχνοντας το εικονίδιο αυτό της κίνησης σε έναν άλλο κόμβο 

τοποθετεί τον κόμβο τοποθετείται ο κόμβος-στόχος στις ίδιες 

πληροφορίες που έχουν οριστεί σαν κόμβος όπου ξεκίνησε η λειτουργία 

μεταφοράς. 

Οι πληροφορίες που ανήκουν σε έναν κόμβο μπορούν επίσης να 

επεξεργαστούν μέσα από την επιλογή Edit-> Node . Έτσι εμφανίζεται 

το παράθυρο ιδιοτήτων κόμβου. Οι πληροφορίες θέτουν 

προκαθορισμένες επιλογές στις τρέχουσες πληροφορίες όπου ανήκει ο 

κόμβος επίσης εμπεριέχεται μια λίστα από όλες τις άλλες πληροφορίες 

του παιχνιδιού, οι οποίες είναι συμβατές με τον κόμβο. Επιπλέον, ο 

κόμβος μπορεί να μετακινηθεί σε ένα νέο σύνολο πληροφοριών που 
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καθορίζονται από τη ρύθμιση της αναπτυσσόμενης λίστα για το νέο 

σύνολο των πληροφοριών εισόδου. 

Κατά τη δημιουργία παιχνιδιού τύπου δέντρου, χρησιμοποιώντας 

την προσέγγιση Dart-and-drop για την αντιγραφή τμημάτων του 

δέντρου, οι κόμβοι που δημιουργούνται στο αντίγραφο του υποδένδρου 

παραμένουν στις ίδιες πληροφορίες που με τις αντίστοιχες των κόμβων 

του αρχικού υπόδενρου. Σε πολλές περιπτώσεις, όμως, τα δέντρα αυτά 

διαφέρουν ως προς τις διαθέσιμες πληροφορίες για μερικούς ή όλους 

τους παίκτες.  

Για να συμβάλει στην επιτάχυνση της διαδικασίας προσαρμογής 

της πληροφορίας το Gambit προσφέρει μια λειτουργία «αποκάλυψη», η 

οποία σπάει σύνολα δεδομένων με βάση τη δράση τους σε ένα 

συγκεκριμένο κόμβο. Κάνοντας κλικ σε έναν κόμβο στον οποίο τα 

μέτρα που ελήφθησαν πρόκειται να γίνουν γνωστά στη συνέχεια σε 

άλλους παίκτες, και επιλέγοντας Edit-> Reveal, εμφανίζεται ένα 

παράθυρο με τη λίστα των παικτών στο παιχνίδι. Επιλέγοντας τα 

πλαίσια δίπλα στους παίκτες που τηρούν το αποτέλεσμα της κίνησης 

στον κόμβο, και κάνοντας κλικ στο OK, οι πληροφορίες στους κόμβους 

κάτω από τον επιλεγμένο ρυθμίζονται με βάση την επιλεγμένη ενέργεια 

σε αυτόν τον κόμβο. 

3.5 Αποτελέσματα και αποδόσεις. 

 

ΤΟ Gambit υποστηρίζει την προδιαγραφή των αποδόσεων σε 

κάθε κόμβο σε ένα παιχνίδι μορφής δέντρου, είτε είναι τερματικός είτε 

όχι. Στην περίπτωση αυτή, το αποτέλεσμα σε κάθε κόμβο είναι μηδέν σε 

όλους τους παίκτες. Στην περίπτωση όπου κάθε κόμβος που 

δημιουργείται δεν περιέχει κάποια απόδοση, τότε αποτέλεσμα τους είναι 

μηδέν για όλους τους παίκτες. Οι περιπτώσεις αυτές αναφέρονται 
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παιχνίδια μορφής δέντρου με την παρουσία ενός (υ) χρώματος ανοιχτό 

γκρι στην αριστερή μεριά κάθε κόμβου. 

Για τη ρύθμιση των αποδόσεων σε έναν κόμβο, θα πρέπει να γίνει 

διπλό κλικ στην ένδειξη (u) στα δεξιά του κόμβου. Έτσι δημιουργείται 

μια νέα έκβαση στον κόμβο, με απόδοση μηδέν για όλους τους παίκτες, 

και εμφανίζεται ένας συντάκτης για τη ρύθμιση της απόδοσης του 

πρώτου παίκτη. 

Η απολαβή σε έναν παίκτη για ένα αποτέλεσμα μπορεί να 

επεξεργαστεί με διπλό κλικ στην καταχώρηση πληρωμής. Η ενέργεια 

αυτή δημιουργεί ένα στοιχείο ελέγχου επεξεργασίας κειμένου στο οποίο 

η πληρωμή για τον εν λόγω παίκτης μπορεί να τροποποιηθεί. Η 

επεξεργασία της πληρωμής μπορεί να γίνει αποδεκτή πατώντας το 

πλήκτρο Εnter. Επιπλέον, η αποδοχή της πληρωμή γίνεται πατώντας το 

πλήκτρο Tab και οι δύο αλλαγές κατοχυρώνονται στην πληρωμή του 

παίκτη. 

Τα αποτελέσματα μπορούν επίσης να μετακινηθούν ή να 

αντιγραφούν χρησιμοποιώντας τη λειτουργία drag-and-drop. Κάνοντας 

αριστερό κλικ και σέρνοντας ένα αποτέλεσμα σε έναν άλλο κόμβο, τότε 

κινείται το αποτέλεσμα από τον αρχικό κόμβο στον κόμβο-στόχο. Η 

αντιγραφή του αποτελέσματος μπορεί να επιτευχθεί με τον ίδιο τρόπο, 

ενώ κρατώντας πατημένο το πλήκτρο Control (Ctrl) στο πληκτρολόγιο. 

Όταν γίνεται χρήση της λειτουργίας της αντιγραφής που 

περιγράφεται παραπάνω, γίνεται εκχώρηση των ίδιων αποτελεσμάτων 

στους εμπλεκόμενων κόμβους. Ως εκ τούτου, εάν στη συνέχεια οι 

αποδόσεις για το αποτέλεσμα έχουν εισαχθεί, τότε οι αποδόσεις και 

στους δύο κόμβους θα τροποποιηθούν. Για να γίνει αντιγραφή του 

αποτελέσματος με τέτοιο τρόπο ώστε το αποτέλεσμα στον κόμβο-στόχος 

να είναι διαφορετικό αποτέλεσμα από αυτό της πηγής, αλλά με τις ίδιες 

απολαβές, θα πρέπει να είναι πατημένο το πλήκτρο Shift, αντί του 
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πλήκτρου Control (Ctrl) κατά τη μετακίνηση. Για να γίνει αφαίρεση 

ενός αποτελέσματος από έναν κόμβο ,θα πρέπει να γίνει κλικ στον 

κόμβο και επιλογή Edit -> Remove Outcome. 

 

3.6 Έλεγχος διάταξης ενός δέντρου. 
 

 Το Gambit εφαρμόζει ένα αυτόματο σύστημα διάταξης παιχνιδιών 

παιγνίου σε μορφή δέντρου, το οποίο παρέχει γενικά αξιόπιστα 

αποτελέσματα για τα περισσότερα παιχνίδια. Η ρύθμιση τους μπορεί να 

γίνει μέσα από τις επιλογές Format -> Layout. 

 

Οι παράμετροι διάταξης οργανώνονται σε τρείς καρτέλες. 

 Η πρώτη καρτέλα με τίτλο Nodes (κόμβοι), ελέγχει το μέγεθος, 

την τοποθεσία και την απόδοση των κόμβων στο δέντρο. Οι κόμβοι 

μπορεί να δηλώνονται με πέντε διαφορετικά σχήματα: μία οριζόντια 

γραμμή , κουτί, διαμάντι , άδειος κύκλος και γεμάτος κύκλος. Τα 

σχήματα αυτά μπορούν να ρυθμιστούν ανεξάρτητα για να διακρίνουν 

την πιθανότητα και τους τερματικούς κόμβους από τους κόμβους των 

παικτών. 
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 Η δεύτερη καρτέλα με τίτλο Branches (κλαδιά ) ,ελέγχει την 

εμφάνιση των κλαδιών του δέντρου. Ο παραδοσιακός τρόπος του 

Gambit για την κατάρτιση των κλαδιών είναι μια προσέγγιση fork-tine 

από το στην οποία υπάρχει ένα επίπεδο μέρος στο τέλος κάθε κλαδιού 

στο οποίο εμφανίζονται ετικέτες. Εναλλακτικά τα κλαδιά μπορούν να 

ενσωματωθούν σχεδιάζοντας ευθείες γραμμές μεταξύ των κόμβων. 
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 Τέλος, η τρίτη καρτέλα με τίτλο Information Sets (Σύνολο 

πληροφοριών) απεικονίζει το σύνολο των πληροφοριών. Οι 

πληροφορίες μπορούν να τροποποιηθούν χρησιμοποιώντας μια ενιαία 

γραμμή για τη σύνδεση των κόμβων. Η χρήση των γραμμών για τη 

σύνδεση των κόμβων μπορεί να οδηγήσει σε μια πιο συμπαγή 

αναπαράσταση του δέντρου όπου υπάρχουν πολλά σύνολα πληροφοριών 

σε μια ίδια οριζόντια θέση. 

 

 

 Η διάταξη του δέντρου μπορεί να είναι τέτοια ώστε τα μέλη της 

ίδιας ομάδας να εμφανίζονται σε διαφορετικές οριζόντιες θέσεις στο 

δέντρο. Σε μια τέτοια περίπτωση, από προεπιλογή του προγράμματος 

σχεδιάζεται ένα οριζόντιο βέλος που δείχνει από την δεξιά ή την 

αριστερή μεριά , τη συνέχιση του συνόλου των πληροφοριών. Αυτού 

του τύπου οι συνδέσεις μπορούν να απενεργοποιηθούν θέτοντας 

πληροφορίες στους παίκτες μόνο όταν βρίσκονται σε ίδιο επίπεδο.  
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3.7 Παιχνίδια στρατηγικής 
 

To Gambit προσφέρει πλήρη υποστήριξη στην κατασκευή και το 

χειρισμό παιχνιδιών στρατηγική μορφής. 

Για τα παιχνίδια εκτεταμένης μορφής, το Gambit υπολογίζει 

αυτόματα το αντίστοιχο μειωμένο στρατηγικό παιχνίδι. Για να 

εμφανιστεί το μειωμένο στρατηγικό παιχνίδι που αντιστοιχεί σε ένα 

εκτεταμένο παιχνίδι, θα πρέπει να επιλεγεί View -> Strategic game ή να 

γίνει κλικ στο εικονίδιο στο εικονίδιο Strategic game (στρατηγικό 

παιχνίδι) στην κεντρική γραμμή του μενού όπου βρίσκονται τα εργαλεία 

του προγράμματος. 

 

Τα παιχνίδια στρατηγικής μορφής υπολογίζονται από το Gambit 

ως ένα μειωμένο στρατηγικό παιχνίδι ενός εκτεταμένου παιχνιδιού και 
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δεν μπορεί να τροποποιηθεί άμεσα. Αντί να γίνεται επεξεργασία του 

αρχικού εκτεταμένου παιχνιδιού, το Gambit υπολογίζει αυτόματα το 

στρατηγικό παιχνίδι μετά τις όποιες αλλαγές γίνονται στο εκτεταμένο 

παιχνίδι. 

Στρατηγικά παιχνίδια μπορεί επίσης να εισάγονται άμεσα . Για να 

δημιουργηθεί ένα νέο στρατηγικό παιχνίδι, θα πρέπει να επιλεγεί File -

>New -> Strategic game, ή να γίνει κλικ στο εικονίδιο νέου 

στρατηγικού παιχνιδιού στη γραμμή εργαλείων. 

 

 

3.7.1  Πλοήγηση σε ένα στρατηγικό παιχνίδι παιγνίου. 
 

 Το Gambit εμφανίζει τα στρατηγικά παιχνίδια σε μορφή πίνακα. 

Όλοι οι παίκτες που έχουν ανατεθεί είναι είτε παίκτες σειράς είτε 

παίκτες στήλης, και οι αποδόσεις για κάθε καταχώρηση στο στρατηγικό 

πίνακα του παιχνιδιού αντιστοιχούν στις εξοφλήσεις που αντιστοιχεί 

στην κατάσταση κατά την οποία όλοι οι παίκτες παίζουν στη σειρά της 

στρατηγικής που βρίσκονται, και όλοι οι παίκτες στήλης παίζουν τη 

στρατηγική που καθορίζεται στην εν λόγω στήλη όπου ανήκουν. 

Η προεπιλεγμένη παρουσίαση των παιχνιδιών στρατηγικής είναι 

ένας πίνακας που έχει ένα παίκτη γραμμής και έναν παίκτη στήλης. 

Ωστόσο, το Gambit επιτρέπει μια πιο ευέλικτη εκχώρηση, στην οποία 

πολλοί παίκτες μπορούν να αποδοθούν στις σειρές και πολλαπλοί 

παίκτες σε στήλες. Αυτή η δυνατότητα είναι ιδιαίτερα χρήσιμη για 

παιχνίδια με περισσότερους από δύο παίκτες. Σε έντυπη μορφή, ένα 

στρατηγικό παιχνίδι τριών παικτών παρουσιάζεται συνήθως ως μια 
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συλλογή από πίνακες, με έναν παίκτη να επιλέγει τη γραμμή, τον 

δεύτερο να επιλέγει τη στήλη, και τον τρίτο να επιλέγει τον πίνακα. Το 

Gambit παρουσιάζει τέτοια παιχνίδια ιεραρχικά παραθέτοντας τις 

στρατηγικές ενός ή περισσότερους παικτών και στις γραμμές και στις 

στήλες. 

 Στο παρακάτω αυτό, ο πρώτος παίκτης Player 1 με κόκκινο 

χρώμα, έχει τις στρατηγικές που αναφέρονται στις σειρές του πίνακα, 

και ο δεύτερος παίκτης Player2, ο οποίος εμφανίζεται σε μπλε χρώμα, 

έχει τις στρατηγικές που αναφέρονται στις στήλες του πίνακα. 

 

Η ανάθεση των παικτών σε σειρές και στήλης είναι πλήρως 

παραμετροποίηση. Η αλλαγή στην αντιστοίχιση του παίκτη, μπορεί να 

επιτευχθεί σύροντας το εικονίδιο του προσώπου  που εμφανίζεται 

στα αριστερά του ονόματος του παίκτη στη γραμμή εργαλείων του 

μενού σε οποιαδήποτε από τις περιοχές του πίνακα. 

 

3.7.2 Προσθήκη παικτών και στρατηγικών. 

 

 Για να γίνει προσθήκη ενός επιπλέον παίκτη σε ένα παιχνίδι 

στρατηγικής, θα πρέπει να επιλεγεί Edit-> Add Player ή να γίνει κλικ 

στο εικονίδιο προσθήκης νέου παίκτη ,το οποίο βρίσκεται στην γραμμή 

εργαλείων του μενού. 
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Για να γίνει αντίστοιχα προσθήκη μιας νέας στρατηγικής για έναν 

παίκτη , θα πρέπει να γίνει κλικ στο εικονίδιο προσθήκης νέας 

στρατηγικής, το οποίο βρίσκεται στην αριστερή μεριά του ονόματος του 

παίκτη.  

 

 

 

Η επεξεργασία του ονόματος κάθε στρατηγικής γίνεται κάνοντας κλικ 

σε οποιοδήποτε κελί πάνω στο στρατηγικό πίνακα του παιχνιδιού όπου 

εμφανίζεται μια ετικέτα της στρατηγικής όπως φαίνεται και στην 

παρακάτω εικόνα. 
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3.7.3  Επεξεργασία αποδόσεων. 

   

Για να γίνει επεξεργασία των αποδόσεων στον στρατηγικό πίνακα 

του παιχνιδιού, θα πρέπει να γίνει κλικ στα κελιά του πίνακα. Η 

ακύρωση οποιασδήποτε επεξεργασίας γίνεται πατώντας από το 

πληκτρολόγιο το πλήκτρο Escape (Esc), έτσι γίνεται επαναφορά της 

αρχικής τιμής. 

Για να επιτευχθεί η επιτάχυνση της εισόδου πολλαπλών 

αποδόσεων , όπως είναι τυπικό όταν δημιουργείται ένα νέο παιχνίδι 

παιγνίου, κάνοντας αποδοχή μιας εισόδου αποδοχής μέσου του 

πλήκτρου Tab, αυτόματα κινείται το στοιχείο που επεξεργάζεται στο 

επόμενο κελί προς την αριστερή μεριά του πίνακα .Αν η απόδοση 

βρίσκεται στο τελευταίο κελί μιας σειράς τότε η διαδικασία συνεχίζει 

στην επόμενη σειρά του πίνακα. Εστί η εισαγωγή των αποδόσεων σε ένα 

παιχνίδι παιγνίου στρατηγικής μορφής , γίνεται γρηγορότερα . 

 

3.8 Μελέτη κυριαρχούμενων στρατηγικών και δράσεων. 

 

Επιλέγοντας Tools-> Dominance , εναλλάσσεται η εμφάνιση της 

γραμμής εργαλείων, η οποία μπορεί να χρησιμοποιηθεί για τη 

διερεύνηση της δομής των κυριαρχούμενων στρατηγικών και δράσεων. 
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3.8.1 Κυριαρχούμενες δράσεις σε παιχνίδι εκτεταμένης 

μορφής. 

 

Στα παιχνίδια εκτεταμένης μορφής, η νέα γραμμή εργαλείων 

κυριαρχίας, ελέγχει την εξάλειψη των δράσεων που κυριαρχούν υπό 

ορισμένους ρους.  

Οι δράσεις μπορούν να εξαλειφθούν με βάση δύο κριτήρια: 

Αυστηρή κυριαρχία: Η δράση είναι πάντα πιο ασήμαντη από τις 

υπόλοιπες, ανεξάρτητα από τις πεποιθήσεις στο σύνολο των 

πληροφοριών. 

Αυστηρή ή αδύναμη κυριαρχία: Όταν υπάρχει και μια άλλη δράση 

στο σύνολο των πληροφοριών που είναι πάντα τουλάχιστον τόσο καλή 

όσο η δράση, και αυστηρά καλύτερα σε ορισμένες περιπτώσεις. 

Σε γενικές γραμμές, περαιτέρω στάδια στην εξάλειψη δράσεων μπορούν 

να γίνουν με εκ νέου κάνοντας κλικ στο εικονίδιο  επόμενο 

επίπεδο. Η γραμμή εργαλείων παρακολουθεί τον αριθμό των επιπέδων 

της εξάλειψης που εμφανίζονται. Το εικονίδιο  προηγούμενο 

επίπεδο κινείται μέχρι ένα επίπεδο εξάλειψης. 

Η εξάλειψη των πολλαπλών επιπέδων μπορεί να αυτοματοποιηθεί με τη 

χρήση του fast forward εικονίδιο , το οποίο εξαλείφει 

επαναληπτικά κυριαρχούμενες ενέργειες μέχρι να μη μπορεί να γίνει 

καμία περαιτέρω εξάλειψη ενεργειών. Το εικονίδιο προς τα πίσω  

αποκαθιστά την εμφάνιση στο πλήρες παιχνίδι. 

 

3.8.2 Κυριαρχούμενες στρατηγικές σε παιχνίδι στρατηγικής 

μορφής 
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 Η νέα γραμμή εργαλείων κυριαρχίας λειτουργεί στα παιχνίδια 

στρατηγικής μορφής με τον ίδιο τρόπο όπως και στα παιχνίδια 

εκτεταμένης μορφής. Οι στρατηγικές μπορούν να εξαλειφθούν 

επαναληπτικά με βάση το αν αυτά είναι αυστηρά ή ασθενώς 

κυριαρχούμενες. 

 Όταν η γραμμή εργαλείων κυριαρχίας φαίνεται, τότε ο 

στρατηγικός πίνακας περιέχει δείκτες των στρατηγικών που 

κυριαρχούνται. Επιπλέον, οι αποδόσεις που αντιστοιχούν στις 

κυριαρχούμενες στρατηγικές εξαλείφονται εμφανίζοντας σε κάθε κελί το 

σχήμα "Χ".  

 Οι στρατηγικές που κυριαρχούνται ασθενώς ,παρουσιάζονται με 

τον ίδιο τρόπο, εκτός του ότι το σχήμα "Χ" σχηματίζεται με πιο λεπτές 

γραμμές. 

 Τέλος, κάνοντας κλικ στο εικονίδιο επόμενο επίπεδο, εξαλείφονται οι 

αυστηρά κυριαρχούμενες στρατηγικές από την οθόνη. 

 

 

Εικόνα: Εξάλειψη κυριαρχούμενων στρατηγικών. 

 

3.9 Υπολογισμός ισορροπίας Nash. 
 

 Το Gambit προσφέρει ευρεία υποστήριξη για τον υπολογισμό της 

ισορροπίας κατά Nash τόσο σε εκτεταμένης μορφής παιχνίδια αλλά και 

στρατηγικής μορφής. Για να ενεργοποιηθούν οι λειτουργίες αυτές τις 
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εύρεσης των ισορροπιών θα πρέπει να επιλεγεί Tools-> Equilibrium ή 

κλικ στο εικονίδιο , το οποίο αποτελεί συντόμευση και βρίσκεται 

στη γραμμή εργαλείων. 

 

3.9.1 Επιλογή των μεθόδων για την εύρεση των ισορροπιών. 
 

 Η διαδικασία του υπολογισμού των σημείων ισορροπίας Nash στα 

παιχνίδια εκτεταμένης και στρατηγικής μορφής είναι παρόμοια. Αυτή η 

υποενότητα εστιάζει στην περίπτωση των παιχνιδιών εκτεταμένης 

μορφής. Η διαδικασία για τα παιχνίδια στρατηγικής είναι ανάλογη, 

εκτός από τα παιχνίδια εκτεταμένης μορφής με ειδικά χαρακτηριστικά, 

όπως η εμφάνιση των προφίλ στο δέντρο του παιχνιδιού, η οποία δεν 

ισχύει. 

Το Gambit παρέχει καθοδήγηση σχετικά με τις επιλογές για τον 

υπολογισμό της ισορροπίας Nash σε μια καρτέλα . 

 

 Οι μέθοδοι που εφαρμόζονται σε ένα συγκεκριμένο παιχνίδι 

εξαρτώνται από τρία κριτήρια: τον αριθμό των ισορροπιών που πρέπει 

να υπολογιστούν, ασχέτως αν ο υπολογισμός πρέπει να γίνει σε 

παιχνίδια εκτεταμένης ή στρατηγικής μορφής, καθώς και στις 

λεπτομέρειες του παιχνιδιού, όπως για παράδειγμα αν το παιχνίδι έχει 

δύο ή περισσότερους παίκτες , και αν το παιχνίδι είναι σταθερού ποσού. 
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Το πρώτο βήμα για την εύρεση ισορροπίας είναι o καθορισμός 

του αριθμού των ισορροπιών προς εύρεση. Ορισμένοι αλγόριθμοι 

υπολογισμού ισορροπιών είναι προσαρμοσμένοι στην εύρεση μιας 

ενιαίας ισορροπία, ενώ άλλοι προσπαθούν να υπολογίσουν όλο το 

σύνολο των ισορροπιών. Η πρώτη επιλογή στην καρτέλα υπολογισμού 

ισορροπιών καθορίζει πόσες ισορροπίες θα πρέπει να υπολογιστούν.

  

Οι επιλογές που διατίθενται είναι ο υπολογισμός μια ισορροπίας Nash, η 

εύρεση όσο το δυνατόν περισσότερων ισορροπιών και ο υπολογισμός 

όλων των ισορροπιών. Για ορισμένα παιχνίδια, υπάρχουν αλγόριθμοι 

που υπολογίζουν πολλές ισορροπίες (σχετικά) αποτελεσματικά, αλλά 

δεν είναι εγγυούνται την εύρεση όλων των ισορροπιών. 

Για να απλοποιηθεί η διαδικασία της επιλογής της μεθόδου για 

τον υπολογισμό των ισορροπιών στην δεύτερη επιλογή ,  

  

το Gambit παρέχει για κάθε παιχνίδι μεθόδους για τον υπολογισμό ενός, 

μερικών, και όλων των ισορροπιών Nash, αντίστοιχα. Αυτές οι μέθοδοι 

επιλέγονται με βάση την εμπειρία ως προς την αποτελεσματικότητα και 

την αξιοπιστία των μεθόδων, και γενικότερα λειτουργούν αξιόπιστα για 
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τα περισσότερα παιχνίδια. Για περισσότερο έλεγχο επί της διαδικασίας, 

ο χρήστης μπορεί να επιλέξει από το δεύτερη αναπτυσσόμενη λίστα μία 

από τις κατάλληλες μεθόδους για τον υπολογισμό ισορροπιών. Αυτή η 

λίστα εμφανίζει μόνο τις μεθόδους που είναι κατάλληλες για το παιχνίδι, 

με δεδομένη την επιλογή του αριθμού των ισορροπιών που πρέπει να 

υπολογιστούν. 

Τέλος, για τα παιχνίδια εκτεταμένης μορφής, υπάρχει η επιλογή 

του αν θα χρησιμοποιήσει εκτεταμένο ή στρατηγικό παιχνίδι για τον 

υπολογισμό. 

  

Σε γενικές γραμμές, ο υπολογισμός με τη χρήση εκτεταμένου παιχνιδιού 

προτιμάται, δεδομένου υπάρχει πιο συχνά μια πολύ πιο συμπαγή 

αναπαράσταση των στρατηγικών χαρακτηριστικών του παιχνιδιού. 

Ακόμα και για τα παιχνίδια μετρίου μεγέθους, ο υπολογισμός της 

ισορροπίας μπορεί να είναι μια χρονοβόρα διαδικασία. Το Gambit 

εκτελεί όλους τους υπολογισμούς στο παρασκήνιο, και εμφανίζει ένα 

παράθυρο που δείχνει όλα τα σημεία ισορροπίας που έχουν υπολογιστεί 

μέχρι στιγμής.  
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Ο υπολογισμός μπορεί να ακυρωθεί οποιαδήποτε στιγμή κάνοντας κλικ 

στο εικονίδιο ακυρώσει, η οποία τερματίζει τον υπολογισμό αλλά 

διατηρεί οποιαδήποτε ισορροπία έχει υπολογιστεί. 

3.10 Προβολή προφίλ υπολογιζόμενων ισορροπιών στο 

παιχνίδι. 
 

 Μετά τον υπολογισμό των ισορροπιών , εμφανίζεται αυτόματα 

ένας πίνακας , ο οποίος παρουσιάζει μια λίστα με τις ισορροπίες που 

έχουν υπολογισθεί. Ο πίνακας αυτός μπορεί να ενεργοποιηθεί 

επιλέγοντας View->Profiles ή κάνοντας κλικ στο εικονίδιο  στη 

γραμμή εργαλείων. 

 

Εάν βρεθούν περισσότερες από μια ισορροπίες, τότε καταγράφονται 

όλες τις ισορροπίες που βρέθηκαν και ομαδοποιούνται σε με ξεχωριστή 

λίστα προφίλ, η οποία εμφανίζεται στο επάνω αριστερό μέρος του 

πίνακα. Στην παραπάνω εικόνα έχει επιλεγεί να εμφανίζεται η πρώτη 

στήλη προφίλ Ενώ στην κορυφή του πίνακα, αναγράφεται μια σύντομη 
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περιγραφή της μεθόδου που χρησιμοποιήθηκε για τον υπολογισμό της 

ισορροπίας. 

 

 

 

 

 

 

 

 

 

ΚΕΦΑΛΑΙΟ ΤΕΤΑΡΤΟ 

ΠΑΡΑΔΕΙΓΜΑΤΑ 
 

4.1 Παράδειγμα : Δίλημμα των κρατουμένων  
 

Ένα από τα δημοφιλέστερα προβλήματα στη θεωρία παιγνίων 

είναι αυτό του διλλήματος των κρατουμένων. Συγκεκριμένα, αφορά δύο 

κρατούμενους, οι οποίοι έχουν συλληφθεί για κάποιο αδίκημα. 

 Οι αστυνομικοί που τους συνέλαβαν δεν έχουν όλα τα απαραίτητα 

στοιχεία ώστε να φυλακίσουν άμεσα τους κρατούμενους , πράγμα που 

γνωρίζουν και οι ίδιοι οι κρατούμενοι.  

 Η ανάκριση των κρατούμενων γίνεται σε χωριστά δωμάτια ώστε να μην 

υπάρχει καμία επικοινωνία μεταξύ τους. 

 Ο κάθε κρατούμενος έχει δύο επιλογές, είτε να ομολογήσει για το 

αδίκημα και να προδώσει τον συνεργό του, είτε να μην ομολογήσει για 

το αδίκημα. 
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Παρακάτω εμφανίζεται ο πίνακας με τις αποδόσεις κάθε επιλογής-

κίνησης για κάθε κρατούμενο. 

 

 ΚΡΑΤΟΎΜΕΝΟΣ 2 

 

ΚΡΑΤΟΥΜΕΝΟΣ 1 

 Ομολογία Άρνηση 

Ομολογία 5 5 0 10 

Άρνηση 10 0 1 1 

 

 

 

 

 

Ανάλυση των αποδόσεων του πίνακα. 

 

 Αν ομολογήσουν και οι δύο κρατούμενοι τότε η ποινή φυλάκισης 

θα είναι 5 χρόνια για τον καθένα. 

 Αν δεν ομολογήσει κανένας από τους δύο κρατούμενους τότε η 

ποινή φυλάκισης θα είναι 1 χρόνος για τον καθένα. 

 Αν ομολογήσει μόνος ένας από τους δύο κρατούμενους τότε ο 

ίδιος θα αφεθεί ελεύθερος ενώ ο συνεργός του θα λάβει ποινή 

φυλάκισης 10 ετών. 

 

Λύση του προβλήματος με τη χρήση του Gambit. 

 

Εφόσον γίνει επιλογή της εκκίνησης του προγράμματος εμφανίζεται το 

παρακάτω προκαθορισμένο παράθυρο του προγράμματος. 
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Στη συνέχεια, μέσα από τις επιλογές Files->New Strategic Game ,

 

 γίνεται η δημιουργία ενός νέου παιγνίου στρατηγικής μορφής όπως 

στην παρακάτω εικόνα. 
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Επόμενο βήμα είναι η ονομασία του παιχνιδιού που μόλις 

δημιουργήθηκε μέσα από τις επιλογές Edit -> Game. 

 

Στο πλαίσιο Title που εμφανίζεται στο παρακάτω παράθυρο, 

αναγράφεται η ονομασία του παιχνιδιού ,όπου στην προκειμένη 

περίπτωση είναι το «Δίλλημα Κρατουμένων». 

 

Στη συνέχεια, θα πρέπει να δοθούν ονομασίες στα ονόματα των παικτών 

, στις επιλογές τους καθώς επίσης να εισαχθούν μέσα στον πίνακα τα 

δεδομένα. Αυτό επιτυγχάνεται κάνοντας κλικ σε κάθε πεδίο που 

χρειάζεται.  
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Υπολογισμός Ισορροπίας κατά Nash. 

 

Εφόσον έχουν γίνει οι παραπάνω λειτουργίες για την εισαγωγή του 

προβλήματος στο Gambit, μπορεί να επιτευχθεί η επίλυση του 

υπολογίζοντας την ισορροπία κατά Nash. 

Η ισορροπία Nash υπολογίζεται μέσα από τις επιλογές Tools-> 

Εquilibrium ή κάνοντας κλικ στο εικονίδιο , το οποίο βρίσκεται 

στην γραμμή εργαλείων του προγράμματος. 

 

Μέσα από αυτή την επιλογή εμφανίζεται το παρακάτω παράθυρο. Όπου 

επιλέγεται Compute all Nash equilibria και with Gambit’s 

recommended method. Οι επιλογές αυτές αφορούν τον υπολογισμό 

όλων των πιθανών ισορροπιών του παιχνιδιού στην πρώτη περίπτωση 

και τον υπολογισμό μέσω της προκαθορισμένης μεθόδου του Gambit. 
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Επιλέγοντας OK στο παραπάνω παράθυρο γίνεται ο υπολογισμός της 

ισορροπίας και εμφανίζεται η λύση σε ένα νέο παράθυρο, το οποίο 

απεικονίζεται στην παρακάτω εικόνα. 

 

 

Υπενθυμίζουμε ότι με κόκκινο χρώμα απεικονίζονται οι επιλογές για τον 

Κρατούμενο 1 ενώ με μπλε χρώμα οι επιλογές για τον Κρατούμενου 

2.Το αποτέλεσμα της αναζήτησης των ισορροπιών είναι η εύρεση μιας 

μόνο ισορροπίας Nash πράγμα που φαίνεται στο πάνω δεξιά μέρος του 

παραπάνω παραθύρου.  
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Όσον αφορά τις κυρίαρχες στρατηγικές του κάθε κρατούμενου , αυτές 

συμβολίζονται με τον αριθμό 1 στη δεύτερη γραμμή του νέου πίνακα 

που εμφανίστηκε. Συγκεκριμένα, κυρίαρχη στρατηγική και για τους δύο 

κρατούμενους είναι η Άρνηση δηλαδή να μην ομολογήσει κανείς τους 

για το αδίκημα. 

 

4.2 Παράδειγμα: Διακοπές (Δυναμικό παίγνιο) 

 

Το παράδειγμα που θα αναλυθεί και θα επιλυθεί στη συνέχεια, είναι ένα 

δυναμικό παίγνιο το οποίο περιγράφεται υπό την μορφή δέντρου. 

Συγκεκριμένα, αφορά ένα ζευγάρι τον Κώστα και την Μαρία, οι οποίοι 

επιθυμούν να πάνε ένα ταξίδι. Το ταξίδι θα γίνει είτε στο εξωτερικό είτε 

στο εσωτερικό της Ελλάδας.  

 Ο Κώστας θα είναι αυτός που θα επιλέξει αν το ταξίδι θα γίνει 

στην Ελλάδα ή στο Εξωτερικό ,ενώ η Μαρία θα επιλέξει βάση της 

επιλογής του συντρόφου της την πόλη ή το νησί όπου θα 

επισκεφθούν.  

 Εάν ο Κώστας επιλέξει να πάνε στο εξωτερικό τότε η Μαρία θα 

προτείνει δύο πόλεις, το Παρίσι και το Λονδίνο.  

 Εάν ο Κώστας επιλέξει το ταξίδι να γίνει στην Ελλάδα τότε η 

Μαρία θα προτείνει να πάνε Στη Σαντορίνη ή στη Μύκονο. 

 

 

 

Παρακάτω φαίνεται ο πίνακας των αποδόσεων για την ευχαρίστηση που 

θα εκλάβει ο καθένας από κάθε επιλογή.(όσο μεγάλος είναι ο αριθμός 

τόσο μεγαλύτερη είναι και η ευχαρίστηση) 
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 ΜΑΡΙΑ 

 

ΚΩΣΤΑΣ 

 Λονδίνο Παρίσι 

Εξωτερικό 4 3 3 5 

Εσωτερικό 6 2 3 4 

 

-Να βρεθεί ο προορισμός του ταξιδιού που θα δώσει την μεγαλύτερη 

ευχαρίστηση στο ζευγάρι. 

 

Λύση του προβλήματος με τη χρήση του Gambit. 

 

Εφόσον γίνει εκκίνηση του προγράμματος θα πρέπει να δημιουργηθεί 

ένα νέο παιχνίδι παιγνίου Δυναμικής μορφής μέσα από τις επιλογές File-

>New->Extensive Game. 

 

 

Στη συνέχεια εμφανίζεται το παρακάτω παράθυρο όπου μπορεί να γίνει 

η διαμόρφωση του δενδροδιαγράμματος.  
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Προτού γίνουν όμως γίνει η εισαγωγή του προβλήματος στο πρόγραμμα 

θα πρέπει να δοθεί μια ονομασία στο πρόβλημα μέσα από τις Επιλογές 

Edit-> Game  

 

 

 



57 
 

Δημιουργία δενδροδιαγράμματος. 

 

Κάνοντας δεξί κλικ στην μαύρη κουκίδα δηλαδή τον πρώτο κόμβο και 

στη συνέχεια επιλογή Insert move ,εμφανίζεται ένα νέο μικρότερο 

παράθυρο όπου υπάρχουν ορισμένες επιλογές για την εισαγωγή της 

κίνησης. 

 

 

 

Το νέο παράθυρο που εμφανίζεται περιλαμβάνει επιλογές όπως επιλογή 

του παίκτη που θα κάνει την κίνηση καθώς επίσης και την επιλογή του 

αριθμού των παρακλαδιών που θα εμφανιστούν. Στη συγκεκριμένη 

περίπτωση την πρώτη κίνηση την κάνει ο Κώστας.  

Κάνοντας κλικ στη επιλογή ΟΚ εμφανίζεται η κίνηση που 

δημιουργήθηκε για τον παίκτη Κώστα. 
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Στη συνέχεια, ακολουθώντας την ίδια διαδικασία μόνο που αυτή τη 

φορά οι δύο νέες κινήσεις αφορούν την Μαρία, δημιουργείται ολόκληρο 

το δενδροδιάγραμμα. 

 

Επόμενο βήμα είναι η εισαγωγή των τιμών και η ονομασία κάθε 

επιλογής, αυτό επιτυγχάνεται κάνοντας κλικ σε κάθε πεδίο που 

χρειάζεται πάνω στο δενδροδιάγραμμα. 
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Υπολογισμός Ισορροπίας κατά Nash. 

 

Εφόσον γίνουν οι παραπάνω λειτουργίες για την εισαγωγή του 

προβλήματος στο Gambit, μπορεί να επιτευχθεί η επίλυση του 

υπολογίζοντας την ισορροπία κατά Nash. 

Η ισορροπία Nash υπολογίζεται μέσα από τις επιλογές Tools-> 

Εquilibrium 

  

ή κάνοντας κλικ στο εικονίδιο , το οποίο βρίσκεται στην γραμμή 

εργαλείων του προγράμματος. 
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Εφόσον γίνει η επιλογή της εύρεσης της ισορροπίας κατά Nash, 

εμφανίζεται ένα νέο παράθυρο το οποίο περιλαμβάνει επιλογές όπως ο 

αριθμός των ισορροπιών που επιθυμούμε να υπολογιστούν . 

 

Στην προκείμενη περίπτωση οι επιλογές που θα γίνουν είναι οι εξής:  

 Compute all Nash equilibria (εύρεση όλων των ισορροπιών)  

 With Gambit’s recommended method (χρήση προκαθορισμένης 

μεθόδου υπολογισμού του Gambit) 

 Using the extensive game (χρήση του δυναμικού παιχνιδιού) 

 

Εφόσον γίνει κλικ στην επιλογή OK, εμφανίζεται στο κάτω μέρος της 

ίδιας οθόνης το αποτέλεσμα του προβλήματος. 
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Όπως διαπιστώνεται και από την παραπάνω εικόνα, το σημείο 

ισορροπίας του προβλήματος είναι η επιλογή της Σαντορίνης που δίνει 

Payoff (απόδοση) δηλαδή ευχαρίστηση 3 μονάδες για τον Κώστα και 4 

μονάδες για την Μαρία. 

 

4.3 Παράδειγμα Ποδόσφαιρο( παίγνιο μηδενικού 

αθροίσματος) 
  

Στο παρακάτω παίγνιο αναλύεται η διαφορά που υπάρχει μεταξύ μιας 

αμιγής και μιας μεικτής στρατηγικής.  

 

Το παράδειγμα έχει ως εξής: Σε έναν τελικό ποδοσφαίρου ο αγώνας 

κρίνεται στον τελευταίο πέναλτι όπου ο παίκτης 1 είναι ο 

τερματοφύλακας και ο παίκτης 2 αυτός που θα εκτελέσει το πέναλτι. 
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Παρακάτω εμφανίζεται ο πίνακας με τις αποδόσεις για κάθε κίνηση: 

 

 Παίκτης 2 

  

Παίκτης 1 

 Δεξί σουτ  Αριστερό σουτ 

Εκτίναξη δεξιά 0 0 -5 5 

Εκτίναξη αριστερά  -5  5  0  0  

 

Ανάλυση των αποδόσεων: 

 

 Αν αποκρούσει ο Παίκτης 1, τότε η απόδοση για την 

ομάδα του θα είναι πέντε πόντοι. Σε αυτή την περίπτωση η 

ομάδα του Παίκτη 2 θα αποκομίσει μηδέν βαθμούς. 

 Αν δεν αποκρούσει ο Παίκτης 1 το σουτ ,τότε η απόδοση 

για την αμάδα του θα είναι μηδέν. Σε αυτή τη ν περίπτωση 

η ομάδα του Παίκτη 2 θα αποκομίσει τους πέντε βαθμούς. 

 

Λύση προβλήματος στο Gambit 

 

Εφόσον γίνει εκκίνηση του Gambit , επιλέγεται δημιουργία ενός νέου 

παιγνίου στρατηγικής μορφής μέσα από τις επιλογές Files->New -

>Strategic Game  
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Στη συνέχεια γίνεται η συμπλήρωση του πίνακα επιλέγοντας κάθε φορά 

το πεδίο που θα γίνει η εισαγωγή των δεδομένων. 

 

 

 

Επόμενο βήμα είναι η εύρεση της ισορροπίας κατά Nash μέσα από τις 

επιλογές Tools-> Εquilibrium ή κάνοντας κλικ στο εικονίδιο , το 

οποίο βρίσκεται στην γραμμή εργαλείων του προγράμματος. 
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Μέσα από αυτή την επιλογή εμφανίζεται το παρακάτω παράθυρο. 

 

 

 Όπου επιλέγεται Compute all Nash equilibria και with Gambit’s 

recommended method. Οι επιλογές αυτές αφορούν τον υπολογισμό 

όλων των πιθανών ισορροπιών του παιχνιδιού στην πρώτη περίπτωση 

και τον υπολογισμό μέσω της προκαθορισμένης μεθόδου του Gambit. 

Το αποτέλεσμα του παίγνιου αυτού εμφανίζεται στο κάτω μέρος του 

αρχικού παραθύρου. 
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Συμπέρασμα: Το συγκεκριμένο παίγνιο με μια πρώτη ματιά δεν 

παρουσιάζει καμία ισορροπία κατά Nash. Αυτό συμβαίνει διότι αν ο 

παίκτης 2 αποφασίσει να κάνει σουτ αριστερά τότε ο παίκτης 1 έχει ως 

καλύτερη στρατηγική την εκτίναξη στην αριστερή μεριά ενώ εάν ο 

παίκτης 2 αποφασίσει να κάνει σουτ δεξιά τότε ο παίκτης 1 έχει ως 

καλύτερη στρατηγική την εκτίναξη δεξιά. 

Υπενθυμίζοντας ότι: με τον όρο αμιγείς στρατηγική νοείται μια ειδική 

επιλογή ανάμεσα στις πιθανές κινήσεις σε ένα παίγνιο. Αντίθετα σε μια 

μεικτή στρατηγική ο παίκτης επιλέγει ανάμεσα σε δύο ή περισσότερες 

αμιγείς επιλογές σύμφωνα με προκαθορισμένες πιθανότητες. Παρόλο 

που μερικά παίγνια δεν έχουν ισορροπία κατά Nash στις αμιγείς 

στρατηγικές, 

κάθε παίγνιο έχει μια τουλάχιστον ισορροπία κατά Nash στις μεικτές 

στρατηγικές
5
 

Έτσι και το παράδειγμα αυτό σύμφωνα με τα αποτελέσματα του Gambit, 

παρουσιάζει ένα σημείο ισορροπίας στις μεικτές στρατηγικές. 

Συγκεκριμένα, ο παίκτης 1 θα πρέπει να κάνει σουτ αριστερά με 

πιθανότητα ½ ή να κάνει σουτ δεξιά με πιθανότητα ½. Αντίστοιχα, ο 

παίκτης 2 θα πρέπει να εκτιναχθεί αριστερά με πιθανότητα ½ ή δεξιά με 

πιθανότητα πάλι ½.Συνεπώς, όταν οι παίκτες κάνουν επιλογή των 

παραπάνω μεικτών στρατηγικών , ο καθένας προσπαθεί να κάνει ό,τι 

καλύτερο μπορεί με δεδομένες τις ενέργειες του αντιπάλου. 

Τέλος, αυτό που επισημαίνεται με τις μεικτές στρατηγικές είναι ότι 

υπάρχει ιδιαίτερη σημασία στο να είναι κάποιος παίκτης μη 

προβλέψιμος. 

 

                                                           
5
 D.Besanko – R.Braeutigam, 2008, Μικροοικονομική , Εκδόσεις Gutenberg 
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4.4 Παράδειγμα Αεροπορικές εταιρίες (παίγνιο πλήρους 

πληροφόρησης) 
 

Το παράδειγμα αυτό αγορά δύο ανταγωνιστικές εταιρίες την Aegean και 

την Ryanair.Οι εταιρίες αυτές ανταγωνίζονται στην αγορά των 

αεροπορικών εισιτηρίων. Παρακάτω παρουσιάζεται ο πίνακας με τα 

κέρδη κάθε εταιρίας (σε εκατομμύρια € ) για διάφορους συνδυασμούς 

τιμών που θα μπορούσαν οι δύο εταιρίες να χρεώσουν την τιμή για το 

δρομολόγιο Αθήνα-Λονδίνο. 

 

 

 

 

 

 

 

 

Aegean 

 

 

Ryanair 

 335 € 345 € 355 € 360 € 

300 € 132 380 136 398 140 378 146 382 

320 € 158 402 164 422 170 428 178 416 

340 € 164 424 172 448 180 458 190 450 

350 € 150 426 160 474 170 488 182 490 

 

Λύση του προβλήματος στο Gambit. 

 

Εφόσον γίνει εκκίνηση του Gambit , επιλέγεται δημιουργία ενός νέου 

παιγνίου στρατηγικής μορφής μέσα από τις επιλογές Files->New -

>Strategic Game  
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Η μετατροπή του αρχικού πίνακα 2Χ2 γίνεται 4Χ4 με τη χρήση του 

εικονιδίου  , το οποίο βρίσκεται στις επιλογές του κάθε παίκτη και 

έχει ως λειτουργία την προσθήκη στρατηγικής. Στη συγκεκριμένη 

περίπτωση θα γίνει η χρήση του δύο φορές για κάθε παίκτη. 

 

 

Στη συνέχεια, γίνεται η συμπλήρωση του πίνακα επιλέγοντας κάθε φορά 

το πεδίο που θα γίνει η εισαγωγή των δεδομένων. 

Σημείωση: σε τέτοιου είδους προβλήματα που ο πίνακας είναι 4Χ4 , τα 

δεδομένα εισάγονται γρηγορότερα πατώντας κάθε φορά μετά από 

κάποια εισαγωγή δεδομένου το πλήκτρο Tab ώστε να γίνεται η 

μεταφορά στο αμέσως επόμενο πεδίο. 
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Εφόσον γίνει η κατοχύρωση των δεδομένων στον πίνακα, θα εξετασθεί 

το ενδεχόμενο αν υπάρχει κυρίαρχη στρατηγική για τις δύο αεροπορικές 

εταιρίες. Αυτό γίνεται εφικτό μέσα από τις επιλογές Tools -

>Dominance.  

 

Μετά από την παραπάνω επιλογή εμφανίζεται ο παρακάτω πίνακας , 

από τον οποίο συμπεραίνεται ότι η αεροπορική εταιρία Ryanair είναι η 

μονή που έχει κυρίαρχη στρατηγική. Συγκεκριμένα να κοστολογήσει το 

εισιτήριο για το δρομολόγιο Αθήνα-Λονδίνο στην τιμή των 350 €. Όσον 

αφορά την Aegean, η εταιρεία αυτή έχει μια κυριαρχούμενη στρατηγική 

αυτή της κοστολόγησης στην τιμή των 335€. 
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Στη συνέχεια μέσω της επιλογής , η οποία βρίσκεται στη νέα 

γραμμή εργαλείων που εμφανίζεται, γίνεται η απαλοιφή των 

κυριαρχούμενων στρατηγικών. 

 

 

Το συμπέρασμα από τον παραπάνω πίνακα είναι ότι η αεροπορική 

εταιρία Aegean έχει κυρίαρχη στρατηγική την κοστολόγηση του 
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εισιτήριο στην τιμή των 255€ ενώ οι υπόλοιπες στρατηγικές της, είναι 

κυριαρχούμενες. 

Κάνοντας πάλι την ίδια διαδικασία δηλαδή την απαλοιφή των 

κυριαρχούμενων στρατηγικών μέσω της επιλογής , εμφανίζεται ο 

παρακάτω τελικός πίνακας με τις δύο κυρίαρχες στρατηγικές της κάθε 

αεροπορικής εταιρίας. 

 

 

 

Σημείωση: Η παραπάνω διαδικασία εύρεσης των κυρίαρχων και των 

κυριαρχούμενων στρατηγικών μπορεί να επιτευχθεί συντομότερα με τη 

χρήση της επιλογής  , η οποία παρουσιάζει κατευθείαν τον τελικό 

πίνακα δίχως να παρουσιάζει όλους τους προηγούμενους πίνακες. 
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Υπολογισμός ισορροπίας κατά Nash. 

Η επαλήθευση του παραπάνω αποτελέσματος από τη εύρεση των 

κυρίαρχων στρατηγικών μπορεί να γίνει με τον υπολογισμό της 

ισορροπίας κατά Nash μέσα από τις επιλογές Tools-> Εquilibrium ή 

κάνοντας κλικ στο εικονίδιο , το οποίο βρίσκεται στην γραμμή 

εργαλείων του προγράμματος. 

 

Μέσα από αυτή την επιλογή εμφανίζεται το παρακάτω παράθυρο. 

 

 

 Όπου επιλέγεται Compute all Nash equilibria και with Gambit’s 

recommended method. Οι επιλογές αυτές αφορούν τον υπολογισμό 

όλων των πιθανών ισορροπιών του παιχνιδιού στην πρώτη περίπτωση 

και τον υπολογισμό μέσω της προκαθορισμένης μεθόδου του Gambit. 

Το αποτέλεσμα του παίγνιου αυτού εμφανίζεται στο κάτω μέρος του 

αρχικού παραθύρου. 
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Όπως διαπιστώνεται το σημείο ισορροπίας βρίσκεται όντως στις 

στρατηγικές 340€ για την αεροπορική εταιρία Ryanair και 255€ για την 

αεροπορική εταιρία Aegean. 

 

4.5 Παράδειγμα επίλυσης παιγνίου με τη μέθοδο της 

οπισθογενής επαγωγής. 
 

Οι παίκτες του παιγνίου αυτού είναι οι παίκτης 1 και παίκτης 2 , οι 

οποίοι κατέχουν τις επιλογές Α,Β,Α1,Β1,Α2 και Β2. 

Το παίγνιο είναι διαδοχικό και πλήρους πληροφόρησης. 

 

 Ο παίκτης 1 ξεκινώντας έχει τις επιλογές Α και Β, επιλέγοντας Α 

μπορεί να τερματίσει το παίγνιο αποκομίζοντας όφελος 4 μονάδες και 

όφελος 0 για τον παίκτη 2. 

 Ο παίκτης 2 λόγω του ότι το παίγνιο είναι πλήρους πληροφόρησης 

παρατηρεί την επιλογή του παίκτη 1 και πράττει αναλόγως. 

Συγκεκριμένα, αν ο παίκτης 1 επιλέξει Β τότε επιλέγει Α1 ή Β1, με την 

επιλογή Α1 προσφέρει όφελος και στους δύο παίκτες 2 μονάδες. 
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 Στη συνέχεια, ο παίκτης 1 επιλέγει Α2 ή Β2 με την προϋπόθεση 

ότι οι προηγούμενες επιλογές ήταν οι Β και ή Β1. Οι επιλογές του 

παίκτη 1 σε αυτό το στάδιο τερματίζουν το παίγνιο. Η επιλογή Α2 

προσφέρει στον παίκτη 1 6 μονάδες και 0 μονάδες στον παίκτη 2, ενώ η 

επιλογή Β2 προσφέρει αντίστοιχα 0 και 4 μονάδες. 

 

 

Οι παραπάνω πληροφορίες σχετικά με τα οφέλη και τις επιλογές των 

δύο παικτών παρουσιάζονται στο παρακάτω δενδρόγραμμα.  

 

 

Εικόνα: Δενδρόγραμμα παραδείγματος οπισθογενής επίλυσης. 

 

Λύση του παιγνίου 

 

Όπως είναι ήδη γνωστό από τη θεωρία της οπισθογενής επαγωγής, η 

επίλυση τέτοιων παιγνίων ξεκινάει από το τελευταίο στάδιο. Στην 

προκείμενη περίπτωση το τελευταίο στάδιο είναι το τρίτο δηλαδή η 

δεύτερη κίνηση του παίκτη 1.  
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Στο τρίτο στάδιο ο παίκτης 1 έχει να επιλέξει μεταξύ των επιλογών Α2 

και Β2 , οι οποίες του αποφέρουν όφελος 6 και 0 αντίστοιχα όπου 

επιλέγει την άριστη επιλογή Α2. 

Στο δεύτερο στάδιο ο παίκτης 2 προβλέπει ότι εάν το παίγνιο φτάσει στο 

τρίτο στάδιο τότε ο παίκτης 1 θα επιλέξει την επιλογή Α2 , η οποία θα 

αποφέρει όφελος 0 μονάδες στον παίκτη 2 διότι ο παίκτης 1 έχει το 

άριστο όφελος των 6 μονάδων. Για αυτό το λόγο ,ο παίκτης 2 θα 

προτιμήσει να επιλέξει την επιλογή Α1 , η οποία θα του αποφέρει 

όφελος 1 μονάδα και θα τερματίσει το παίγνιο παρά να επιλέξει την 

επιλογή Β2, η οποία θα το αποφέρει όφελος 0 μονάδες. 

Στο πρώτο στάδιο ο παίκτης 1 διαπιστώνει ότι ένα επιλέξει την επιλογή 

Β τότε ο παίκτης 2 με τη σειρά του θα επιλέξει την επιλογή Α1 , η οποία 

θα αποφέρει και στους δύο όφελος 2 μονάδων. Εστί, η προτιμότερη 

δηλαδή η άριστη επιλογή του είναι να τερματίσει το παίγνιο επιλέγοντας 

της επιλογή Α αποκομίζοντας όφελος 4 μονάδων. 

 

Σημείωση: με την οπισθογενής επαγωγή η λύση σε ένα παίγνιο όπως και 

το παραπάνω μπορεί βρίσκεται και σε ένα ενδιάμεσο στάδιο και όχι 

απαραίτητα στο πρώτο όπως στην προκείμενη περίπτωση. 

 

4.6 Παράδειγμα επίλυσης παιγνίου με τη μέθοδο Minimax. 
 

Το συγκεκριμένο παράδειγμα είναι ένα παίγνιο μηδενικού αθροίσματος 

όπου δύο παίκτες κατέχουν τις στρατηγικές A1, A2 , A3 και B1, B2, B3 

αντίστοιχα. Σύμφωνα με το θεώρημα του John von Neumann ισχύει ότι 

στα παίγνια μηδενικού αθροίσματος «το άθροισμα των αποδόσεων των 

δύο αντιπάλων για κάθε αποτέλεσμα είναι ίσο με μηδέν.»  
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Παρακάτω παρουσιάζεται ο πίνακας των αποδόσεων των στρατηγικών 

για κάθε παίκτη: 

 

 Παίκτης 2 

 

Παίκτης 1 

 Β1 Β2 Β3 

Α1 -4 4 2 -2 7 -7 

Α2 -2 2 2 -4 0 0 

Α3 -8 8 0 0 -12 12 

Πίνακας αποδόσεων στρατηγικών 

 

Λύση παιγνίου 

 

Η επίλυση του παραπάνω παιγνίου γίνεται με τη μέθοδο Minimax όπου 

κάθε παίκτης προσπαθεί να ελαχιστοποιήσει το μέγιστο κέρδος του 

αντιπάλου του. 

Συγκεκριμένα, ο παίκτης 1 κάνει τις εξής υποθέσεις:  

 εάν επιλέξει τη στρατηγική Α1 τότε ο παίκτης 2 θα επιλέξει τη 

στρατηγική Β1 , η οποία προκαλεί απώλεια 4 μονάδων στον 

παίκτη 1. Άρα Min (A1)= -4 

 εάν επιλέξει τη στρατηγική Α2 τότε ο παίκτης 2 θα επιλέξει πάλι 

τη στρατηγική Β1 , η οποία προκαλεί απώλεια 2 μονάδων στον 

παίκτη 1. Άρα Min (A2)= -2 

 εάν επιλέξει τη στρατηγική Α3 τότε ο παίκτης 2 θα επιλέξει τη 

στρατηγική Β3 , η οποία προκαλεί απώλεια 12 μονάδων στον 

παίκτη 1. Άρα Min (A3)= -12 

Άρα, από τα παραπάνω σενάρια ο παίκτης 1 καλείται να διαλέξει εκείνη 

τη στρατηγική , η οποία θα του αποφέρει την ελάχιστη απώλεια δηλαδή 

τη στρατηγική Α2=-2 μονάδες. 
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Σημείωση: η επιλογή της στρατηγικής Α2 γίνεται μόνο στην περίπτωση 

όπου ο παίκτης 1 είναι ιδιαίτερα απαισιόδοξος ή αρκετά ρεαλιστής. 

Αντίθετα, ο παίκτης 2 κάνει και αυτός τις παρακάτω υποθέσεις: 

 εάν επιλέξει τη στρατηγική Β1 τότε ο παίκτης 1 θα επιλέξει τη 

στρατηγική Α2 , η οποία προσφέρει μόνο 2 μονάδες στον παίκτη 

2. Άρα Min (B1)= 2 

 εάν επιλέξει τη στρατηγική Β2 τότε ο παίκτης 1 θα επιλέξει πάλι 

τη στρατηγική Α2 , η οποία προκαλεί απώλεια 4 μονάδων στον 

παίκτη 2. Άρα Min (B2)= -4 

 εάν επιλέξει τη στρατηγική Β3 τότε ο παίκτης 1 θα επιλέξει τη 

στρατηγική Α1 , η οποία προκαλεί απώλεια 7 μονάδων στον 

παίκτη 2. Άρα Min (B3)= -17 

Άρα, από τα παραπάνω σενάρια ο παίκτης 2 καλείται να διαλέξει εκείνη 

τη στρατηγική , η οποία θα του αποφέρει την ελάχιστη απώλεια δηλαδή 

τη στρατηγική Β1=2 μονάδες. 

Σίφωνα με τον John von Neumann στα παίγνια μηδενικού αθροίσματος 

ισχύει ότι το άθροισμα των τιμών maximin των παικτών είναι ίσο με 

μηδέν, όπως και στο παράδειγμα αυτό το maximin του παίκτη 1 είναι -2 

και του παίκτη 2 είναι 2. 

 

4.7 Παράδειγμα αυτοκινητοβιομηχανίες (Μεικτές 

στρατηγικές ) 
 

Το παράδειγμα αυτό αναφέρεται σε δύο αυτοκινητοβιομηχανίες, την 

FORD και την BMW. Οι αυτοκινητοβιομηχανίες αυτές ανταγωνίζονται 

στην προσθήκη δύο νέων τεχνολογιών σχετικά τους κινητήρες των 

αυτοκινήτων. 
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Παρακάτω εμφανίζεται ο πίνακας με τις αποδόσεις της κάθε 

στρατηγικής για τις δύο αυτοκινητοβιομηχανίες. 

ΒMW 

 

FORD 

 Τεχνολογία Α Τεχνολογία Β 

Τεχνολογία Α 0 0 5 10 

Τεχνολογία Β 10 5 0 0 

 

 

Λύση Παιγνίου 

 

Για την εύρεση ισορροπιών του παραπάνω παιγνίου θα πρέπει να γίνουν 

τα εξής παρακάτω βήματα. 

 

Εφόσον γίνει εκκίνηση του προγράμματος θα πρέπει να δημιουργηθεί 

ένα νέο παιχνίδι παιγνίου Δυναμικής μορφής μέσα από τις επιλογές File-

>New->Extensive Game. 

 

 

 

Στη συνέχεια συμπληρώνονται τα στοιχεία των παικτών και δίνεται 

ονομασία στο παιχνίδι. 



78 
 

 

 

Επόμενο βήμα είναι η δημιουργία του δενδροδιαγράμματος. 

Ο πρώτος παίκτης δηλαδή η αυτοκινητοβιομηχανία FORD είναι εκείνη 

που επιλέγει πρώτη την στρατηγική της. 

 

Κάνοντας δεξί κλικ στην μαύρη κουκίδα δηλαδή τον πρώτο κόμβο και 

στη συνέχεια επιλογή Insert move ,εμφανίζεται ένα νέο μικρότερο 

παράθυρο όπου υπάρχουν ορισμένες επιλογές για την εισαγωγή της 

κίνησης.  
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Στο νέο αυτό παράθυρο γίνεται η επιλογή του παίκτη FORD καθώς 

επίσης και αριθμός των διαθέσιμων κινήσεων του, όπου στην 

προκείμενη περίπτωση είναι η τεχνολογία Α και Β. 

Με τον τρόπο αυτό εμφανίζονται όπως φαίνεται και στην παρακάτω 

εικόνα , οι δύο στρατηγικές του πρώτου παίκτη. 

 

 

 

Ακολουθώντας την ίδια διαδικασία, γίνεται η εισαγωγή των 

στρατηγικών του δεύτερου παίκτη δηλαδή της αυτοκινητοβιομηχανίας 

BMW. 
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Στη συνέχεια δίνεται ονομασία στις στρατηγικές και γίνεται εισαγωγή 

των δεδομένων στο δενδροδιάγραμμα. 

 

 

 

Με τον παραπάνω τρόπο ολοκληρώνεται η διαδικασία εισαγωγής του 

παιγνίου στο πρόγραμμα Gambit. 

Επόμενο βήμα είναι η επίλυση του βρίσκοντας τις ισορροπίες κατά 

Nash. 

Οι ισορροπίες ή η ισορροπία κατά Nash υπολογίζεται μέσα από τις 

επιλογές Tools-> Εquilibrium 

  

ή κάνοντας κλικ στο εικονίδιο , το οποίο βρίσκεται στην γραμμή 

εργαλείων του προγράμματος. 
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Εφόσον γίνει η επιλογή της εύρεσης της ισορροπίας κατά Nash, 

εμφανίζεται ένα νέο παράθυρο το οποίο περιλαμβάνει επιλογές όπως ο 

αριθμός των ισορροπιών που επιθυμούμε να υπολογιστούν . 

 

 

 

Επιλέγοντας OK εμφανίζεται στο κάτω μέρος του ίδιου παραθύρου ο 

πίνακας με τις ισορροπίες δηλαδή τη λύση του παιγνίου. 
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Συμπέρασμα 

Σύμφωνα με τα Payoffs των παικτών η ισορροπία κατά Nash βρίσκεται 

στο σημείο όπου οι αποδόσεις για την FORD και BMW είναι 5 και 10 

μονάδες αντίστοιχα. Η λύση αυτή εμφανίζεται και στο δενδροδιάγραμμα 

όπου η γραμμή της στρατηγικής «Τεχνολογία Β» γίνεται πλέον μαύρη 

και καταλήγει στη στρατηγική «Τεχνολογία Α» της 

αυτοκινητοβιομηχανίας BMW.Εκτός από τη λύση αυτή υπάρχει και η 

λύση #4  σε μεικτές στρατηγικές. 
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